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Lessons - Plan and build your first website (with
podcast)
Plan and build your first website (with podcast)
» Lessons
» Message board

Welcome to your lessons. Some lessons may have quizzes or assignments for additional
learning. Don't forget to join your fellow classmates and instructor on the message board.

Lesson 1

» View single page

Introducing websites
This course covers all the topics everyone faces -- or should face -- when putting up that first
purposeful site, from how to select and organize content to logistical concerns, such as where to
have your site hosted, to implementing e-commerce on a small business site.

What is a website?
It may seem like a pretty basic question, but it's best to get this definition out of the way right off the
bat so as to avoid confusion later. When we talk about websites in this course, we're talking about a
collection of related documents on the web that are linked together and share a beginning file called
a homepage. Web pages are the individual documents that are linked together to form a website.
Because this course is about building websites (not pages), you won't spend a lot of time on the
technical workings of web pages and the Internet -- such as HTML (Hypertext Markup Language),
CGI (Common Gateway Interface), JavaScript, and the hundreds of other protocols and languages
that make the web work. The goal of this course is to prove to you that it's entirely possible to build a
good first site without being a supergeek.

Why are you here?
The reasons people decide to
take a course on building a
website are as diverse as the
web itself. What are your hopes
and expectations for this
course? What kind of website
are you dreaming up? Take a
few moments to meet your
instructor and fellow students
on the class Message Board,
and let us know a little about
you. See you there.
» Compaq Presario CQ50Z
series

This is not to say there's no point to learning to build sites the "hard" way. Anyone considering a
career in website development is encouraged to learn about the more technical aspects of the
web. However, because this is your first site, it should be as much fun and as easy as possible.

What's the big idea?
You can't write a book unless you have some idea what that book is going to be about. You can't
write a song without a clue as to what you want to sing about. In the same way, you can't design
your own website unless you first know why you're creating the website and what's going to be on it.
There are countless reasons for building a website. Examples of reasons you might build a website
include:
Marketing your business
Selling products or services
Publishing your ideas (or musings) to be read by a global audience
Showing off your children or grandchildren
Showing off yourself
Your reason for building a website can be compared to a business's mission statement, which
describes a company's reason for existence. Simply put, a mission statement tells the folks reading
it just what a business is all about -- or at least what the business wants people to think they're all
about. Examples of business mission statements might include:
"We sell cars at the lowest prices"
"Our mission is to provide the latest information on cures for blue-footed pigeon disease"
"All music, all the time"
Your first task in creating your site is to write your website's mission statement.

What's your mission?
Mission statements can be as short as a sentence or as long as a paragraph. To write your own
mission statement, sit down, get comfortable, and put pen to paper or fingers to keyboard. Try to
describe your website's theme concisely in no more than one paragraph. To make it even harder,
your goal is to adhere to a word limit -- use no more than 65 words.

With thin lines, a cool touchpad
design, and a sleek,
touch-control panel, this 7.0 lb.,
15.4" laptop PC redefines
simplicity. In addition to being
ultra stylish, the PCs in the
Presario CQ50Z series are
durable, powerful, and
value-priced.
» Notebook PC accessories

From software, memory, and
cards to carrying cases and
docks, look to HP for all the
accessories you need to make
your notebook PC more suited
to your personal needs.

The heart of your website
The point of this lesson is to help you find your focus before you start designing your website.
Browse the Internet long enough and you'll see plenty of sites that try to do an awful lot and are
often confusing as a result. Some sites, such as Yahoo! or Amazon.com, actually succeed with this
model. However, what works for a large Internet portal or shopping site almost certainly won't work
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for an individual web publisher or a small business owner. The reason is simple: they have the
resources to successfully manage enormous amounts of content and hundreds of different
products. Chances are good that you don't.
To avoid getting bogged down in endless busy-work and ending up with a site that no one can
understand, decide on the central purpose of your site. With your mission statement in hand, you're
almost ready to start your website construction. In the next section, you learn what kind of content
you need to gather to give your website some meat and substance.

Collecting your content
You've decided on your mission. You wrote it. Then you rewrote it. Then you rewrote it again. Now
it's time to gather the content that'll reflect the theme of your site. There are two types of content:

» HP Pavilion Elite PCs

Content you already have: If you're planning a business site, you probably have marketing
brochures, product briefs, sales letters, and the like. Gather these in one place. With luck,
everything you have is already in a digital format, otherwise you'll have to spend at least a
few hours retyping (or scanning) hard copies.
If you're a business owner -- or if you have family members with time to spare -- consider
delegating this task.
Content you may not know you need: If you have competitors, your goal is to get web
surfers to surf your site rather than your competitors' sites. To accomplish this, you have to
find out just what your competitors have on their sites and "do them one better."
Let's say, for example, you want to build a website that provides the ultimate source for kite
enthusiasts. You have a bunch of product brochures, but that really isn't sufficient to build a website
that anyone's going to want to visit. So, it's off to the search engines to see what your competitors
are doing.

The next generation of home
entertainment; access TV,
movies, music and photos,
when and how you want.
» HP monitors

The following are some good search engines you can use for your research:
Google
MSN Search
Yahoo!
Ask
You can use any of these to come up with a list of competitors. For example, searching for kite
dealers, you get list of kite-oriented websites, including the one shown in Figure 1-1.

Find state of the art displays
from HP with excellent picture
quality in stylish designs.

Figure 1-1: One of the competitor sites in the kite web space is Into The Wind.
Enlarge image
The Into The Wind website contains a wide variety of content, including:
Kite kits and supplies
Kite comparisons
Expert advice
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Forums
E-newsletter
Lists of kite-related events
There's a lot of content there and if you're going to compete in this area, you need content that's
equally as dramatic.
Far too many people set out on building their first website with the idea they're going to compete
with a site like Intothewind.com on a shoestring budget. Do not try this at home. It's true that
many of today's most popular sites started out as someone's weekend project, but most of them
didn't have any competition when they started.
When you plan the content for a website, there's also "wish list" content. This is content that you
don't currently have, and isn't found on any competitor site, but that you think would be a great asset
to your site. You may have seen something you like on a non-competitor's site, such as music,
video, newsletters, and so on. Of course, you're walking a fine line here. Put too many things on
your site and you run the risk of having a non-focused, confusing site. Put too little on your site and
you run the risk of being boring.
Now it's time to make a list of what your site is going to contain.

Making a list and checking it twice
Make a complete list of everything you want to have on your website, even if you don't put it all
online right away. First, list everything you own (meaning content -- no one cares about your SUV or
stereo) and have readily available. Next, browse the web and see what your competitors are up to.
Make a list of what they have and from that list, decide what you want to include on your site.
Finally, add all those "must haves" you've seen on other sites to your list, even sites that aren't your
competitors.
After you've made your list, go eat dinner or take a walk. There'll be plenty of time for staring at the
computer later. After your break, return to the list and go over it, item by item. Put a "Yes" next to
the items that really make sense for your site. Write "No" on items that might detract from your site.

Giving your website some structure
Roll up those sleeves again; it's time to get cracking. You're going to sketch out just what your
website will look like. Use pen and paper or any computer drawing tool (including your word
processor). The goal here is to plot out your site in a diagram format. A site diagram shows
everything your site is going to have, along with the relationships between objects.
At this point, your site diagram serves as the blueprint for your site. After you've finished your initial
construction, your site diagram can serve as a tool for visualizing or modifying your site. It can even
be repurposed to give your visitors a bird's-eye view of your content and to provide an alternate
method for them to navigate your site.
The first thing you put on your site diagram is the homepage. Your homepage is the entry point to
the whole site. If your site diagram uses the inverted tree model, such as a family tree, the
homepage should be at the top of the page. Draw a large box for your homepage, and give it a label
("homepage" works, but you can also give it the same name as your site). From the homepage, a
visitor should be able to logically navigate to any page on the site.
It takes some practice to think of websites as inverted trees, and you may make some mistakes.
This is where either an eraser or website diagramming software that allows you to move pages
around comes in handy. See the sidebar, "Need a Site Diagramming Tool?" for more information
about where to find such software. Also, many of the software programs available for designing
websites, such as Microsoft FrontPage, feature a built-in site-diagramming tool. Visit the Web Style
Guide Creating site diagrams web page for information about and illustrations of site diagrams.

Need a website
diagramming tool?
There are a number of tools
available that can make your
site-diagramming job much
easier. Try searching for site
map , sitemap , or site
diagram on a shareware
download site, such as
Download.com . Many of the
tools you'll find can also reverse
engineer an existing site to
create a site diagram. Be
careful which sites you use
such a tool on, however,
because many sites have
thousands of pages and could
potentially tie up your computer
for a while.
» Desktop PCs

One of the benefits of using a tool such as FrontPage is that the program creates the pages for
you as you diagram the site. All that's left for you to do is to fill them with content.
Even with all of the software available to help you create your site diagram, sometimes it helps to
use a pencil and paper at this stage. The important part is to have a plan for how the various types
of content on your site will link together.
Don't worry if you don't know yet how to create the code to execute your ideas. In this lesson, we're
learning how to use the concept of the site diagram to plan out your site.

What's next?

View our wide selection of
desktop PCs to see reliable HP
quality at a great value. We'll
even help you choose the right
desktop for your unique needs.

So, now you've written your website's mission statement, you've created a list of content, gathered
your content, and diagrammed your site. Pretty good for one lesson. Lesson 2 shows you how to
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use the various web designer tools to make that content shine.

» Desktop PC accessories

Before moving on, please complete the brief lesson quiz and assignment. Now is also a good time
to visit the course Message Board and discuss your site diagram with your classmates and the
instructor.

From software and storage to
cables, mice, and keyboards, all
the accessories you need for
your HP desktop PC are
available to make your desktop
experience more personal,
powerful, and attuned to your
specific needs.

Congratulations on completing the lesson! Don't forget the following:
» Assignment: Searching for site maps
» Quiz: Lesson 1, quiz 1
» Discuss what you've learned with your instructor and other students
» Return to the lessons list to get a quick overview of the entire class

Privacy statement

Using this site means you accept its terms

Feedback to Home & Home Office

© 2008 Hewlett-Packard Company, L.P.
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Elements of a website assignment
Assignments are designed to help you apply the information learned in the lessons.
Searching for site maps
As mentioned in Lesson 1, many websites use a site diagram as a navigation aid. When used
in this way, it's usually called a site map. Your assignment is to browse the weband find some
site maps. Notice that many site maps don't show the relationships between content the same
way as your site diagram does. For example, Figure 1-2 shows a simple text-based site map.
Icons differentiate between main and subcategories of content.

Enlarge image
The basic concept of this site map and your diagram is the same: to present a hierarchical
view of the website's content.

Privacy statement

Using this site means you accept its terms

Feedback to Home & Home Office

© 2008 Hewlett-Packard Company, L.P.
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Lesson 1, quiz 1
Quiz: Lesson 1, quiz 1
Quizzes are designed to give you a chance to test your knowledge.

1. True or False: Creating a mission statement is the first thing you need to do to develop a focused website.
A.

True

B.

False

2. True or False: The goal of your website is to present your unique style or showcase your services; therefore, you should
create all the content yourself.
A.

True

B.

False

3. What is a site diagram?
A.

A hierarchical list of everything your website is going to have

B.

A wish list

C.

The collection of tools you use in a web editor to create a website

D.

A collection of all images you plan to use on your website

Privacy statement

Using this site means you accept its terms

Feedback to Home & Home Office

© 2008 Hewlett-Packard Company, L.P.
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United States-English

» Contact HP

Phone orders 1-877-801-7183

Search:
Home & Home Office

All of HP United States

Lesson 1, quiz 1
» Home & Home Office
My Cart
0 items in My Cart

Quiz: Lesson 1, quiz 1
Quizzes are designed to give you a chance to test your knowledge.
Please feel free to take this quiz again. We will update your score.

Hello, Truitt
» Edit profile
» Sign out
» Online classes
» Your classes
» Contact us
» FAQ
» Digital Photography
» Everyday Printing
» PC Learning Center
» Digital Entertainment
» Activity Center
Browse & Buy
» Home & Home Office
Store
» Find a retailer
» Rebate Center
Product Support
» Support &
troubleshooting
» Software & Drivers
» HP Total Care
» Register your product

Quiz Results
1. True or False: Creating a mission statement is the first thing you need to do to develop a focused
website.
A.

True

B.

False

Correct answer(s): A
Explanation:
Although collecting images and learning HTML are important, those are not the first tasks you need to
do. You can't design a good website unless you can develop its focus, or theme, first. HTML and
images come later.

2. True or False: The goal of your website is to present your unique style or showcase your services;
therefore, you should create all the content yourself.
A.

True

B.

False

Correct answer(s): B
Explanation:
There are a lot of sources of content available for free. You just need to search the web to find most of
what you need.

3. What is a site diagram?
A.

A hierarchical list of everything your website is going to have

B.

A wish list

C.

The collection of tools you use in a web editor to create a website

D.

A collection of all images you plan to use on your website

Correct answer(s): A
Explanation:
A site diagram is a visual, structured map of what your site is going to look like.

You got 3 correct out of 3 questions.
Your Score: 100%

Printable version

Privacy statement

» Bookmark HP Online classes

Using this site means you accept its terms
© 2008 Hewlett-Packard Company, L.P.

Feedback to Home & Home Office
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Lessons - Plan and build your first website (with
podcast)
Plan and build your first website (with podcast)
» Lessons
» Message board

Welcome to your lessons. Some lessons may have quizzes or assignments for additional
learning. Don't forget to join your fellow classmates and instructor on the message board.

Lesson 2

» View single page

Get this design started
Now that you've decided what your website is about and what content you're going to have on it, you
need to figure out how to present this information to visitors. That's where your website design
comes in. In this lesson, you learn how to lay out a page, pick colors to use in your site design,
choose fonts, and find and create images for your site. You'll also learn about web usability and
accessibility. We've got a lot to cover, so let's get started.

» Norton Internet Security
2008

Page layout
When you lay out your website, you're creating a framework, or template, that applies to every page
of your site. This framework is where you'll place your content. This template should include site
navigation, the site's logo, a copyright statement, and any other items that should be on every page
of the site. The template should be consistent throughout the site, with the exception of a few cases:
Homepage: Your homepage template can be somewhat different, because it serves as a
gateway to your entire site. However, many designers create the homepage template to be
pretty darned similar to the rest of the site, if not exactly the same. If you have good
reasons, go ahead and make it different -- but not so different as to be unrecognizable as
part of the same site.
Store pages: If part of your site is a store, you probably want to use a different template for
that section. It should be similar in style, but the primary colors might be different, and the
navigation options should be mostly limited to store functionality; therefore, users don't
accidentally leave the store without buying something. You wouldn't want that, would you?
Feedback page: If you have a form for submitting site feedback, put it on a page that has
fewer navigation options than the other pages of your site. After all, you want users to fill out
the form, not be distracted by the other riches your site has to offer.

Travel the Internet while
protected against viruses,
hackers, spyware, and spam.
Stay safe as you e-mail, swap
files, download programs, and
chat. You're automatically
protected when you've got
Norton Internet Security 2008,
updated and enhanced with
more features than ever.
» HP Total Care owner
services

Remember that every page template needs to represent the "look and feel" you've chosen for your
company or endeavor. When a visitor moves around the site, they should feel as if each page is
related to the others and come away with the same sense of purpose from every page. If your
homepage is designed with subdued monotones, your visitors are going to be uneasy if they
suddenly land on a page created in bold primary colors.

Standards exist for a reason
Website design has matured to the point that there are plenty of standards, and it's a pretty good
idea to use them. Putting things where visitors expect to see them helps people use your site.
Logo placement
Website logos are almost always placed in the top-left corner of the page layout and are usually
linked to the homepage. The logo should appear on every page of your site, in the same place. It
can, however, be smaller on interior pages than it is on the homepage. By following this rule, you're
ensuring your visitors always know they're on your site, and know when they've accidentally moved
off the site.

Protect your investment and
achieve greater peace of mind
with the right HP Extended
Service Plan for your needs.

Navigation
Website navigation is almost always in one of two places, and sometimes both, as shown in Figure
2-1:
Top navigation: Along the top of the page or just under the page header, consisting of your
logo, plus a search box and maybe a spot for banner advertising.
Left navigation: In a column on the left side of the page. This is usually used for main
content navigation.
Bottom navigation: Along the bottom of the main frame on the page. These links are
usually reserved for legal and non-commercial related links, such as the site map and
copyright information.
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Figure 2-1: Gone with the Wind Kites Online offers top and left navigation links.
Enlarge image
You can put navigation in both locations, but avoid putting the same navigation items in both
locations. When possible, use the left navigation for general maneuvering through the website and
the top navigation for a more personalized experience, such as account and contact information.
Using the content list you generated in Lesson 1, make a note of how you'll link to that content from
the homepage. Determine which content can be grouped together and reached from a common link,
and then decide which links make sense in the left navigation and which belong at the top. Once
you've figured all that out, it's time to move on to choosing colors. In the next section, you'll learn
how to make good decisions about which colors are right for your site.

All the colors in the rainbow
Every website's got colors -- except maybe one for old-time photography. And why not? Unlike print,
colors on the web don't cost any more than black and white. The temptation is to use all the colors.
This, however, is a bad idea. Your challenge as a website designer is to use colors wisely to create
a website that conveys the appropriate mood without going overboard.

» HP desktop PCs for
everyday computing

Develop your color scheme
One of the first steps in website design is to determine the color scheme you're going to use. You
don't have to decide right away which colors you're going to use where in your page layout, but
knowing which colors you're going to use before you get too far along in your project will save you
lots of headaches later.
The color wheel
You may remember the color wheel from art class or elsewhere. However, the color wheel is poorly
understood by most people. Just so we're all on the same page, let's review the basics. Review the
color wheel shown in Figure 2-2.

HP has a PC with the features
and price range to meet your
needs. Check out the latest
selection today. HP Pavilion
PCs provide the versatile
technology you need to
communicate, create and enjoy
your world more.
» Desktop PC accessories

From software and storage to
cables, mice, and keyboards, all
the accessories you need for
your HP desktop PC are
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available to make your desktop
experience more personal,
powerful, and attuned to your
specific needs.

Figure 2-2: The color wheel.
Colors that go well together are:
Complementary colors: Colors on opposite sides of the color wheel
Triad or tertiary colors: Three colors that are equidistant from each other on the color
wheel
Analogous colors: Colors that are next to each other on the color wheel
Clearly, there are a lot of options here, and the colors that you select are largely based on your own
subjectivity. The key is to pick something that looks good and is appropriate for your website.
Two of one, several of the other
Your color scheme should, in most cases, consist of two main colors, plus one or more second-level
colors. This is not as complicated as it may sound. See Figure 2-3 for an example.

Figure 2-3: A sample color scheme.
Enlarge image
WindPower Sports uses a simple color scheme for its website. You can see the two main colors are
blue and gray. The web designer used blue for the company name and navigation links, with a
darker blue for the category headers. Gray is used as a background color to show off the blue. Two
secondary colors, red and yellow, emphasize important information such as the tag line and phone
number.
Tools to help you
A graphic designer can often help you to determine which colors work well together. When a graphic
designer isn't available, you can use a handy online tool that generates color schemes
automatically.
The Color Schemer Online, shown in Figure 2-4, provides color schemes based on a chosen color.
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The company also sells a software version that provides more functionality.

Figure 2-4: Color Schemer Online can help you develop your color scheme.
Enlarge image
So, what works for my site?
As mentioned previously, your color scheme should be appropriate for the type of site you're
developing. Here are some guidelines to start your thought process:
Sites for children (or child-related topics, like toys) typically use bright primary and secondary
colors such as red, green, yellow, and blue.
Professional and corporate sites tend to use more subdued shades of blue or green (such
as navy blue or forest green), along with grays, tans, and beiges.
Online store color schemes are all over the map and often relate to what they sell. For
example, bath and beauty products can be presented in shades of pink and beige, or forest
green and white. Clothes stores can be a bit bolder, using a bright navy blue or crimson red
along with tan or gray.
Of course, all these color schemes should use plenty of soothing white or light gray, particularly for
text-filled areas. Bold background colors often appear amateurish and distract from the intent of
most websites. In the next section, find out how to use fonts to match the professional appearance
of your colors.

Tips for tasteful font usage
The tasteful use of fonts on a website conveys a professional image, whereas wacky and tacky font
usage does quite the opposite. Depending on the type of site you're creating, you'll want to go one
way or the other. But, in most cases, tastefulness is what you'll be looking for.

» Compaq Presario CQ50Z
series

One serif, one sans-serif
An oft-cited rule is to use one serif font and one sans-serif font in graphic design. There may be
good reason to break this rule sometimes on the web, but it's nonetheless a good place to start.
First, you need to know the difference between serif and sans-serif. If you've used a word processor
in the last 10 years, you've seen them both, but maybe without knowing it:
A serif font has small decorative lines on each letter, and looks somewhat old-fashioned.
Serif fonts are typically used for newspaper stories and novels. Times New Roman and
Georgia are serif fonts. Serif fonts lead the eye from letter to letter, word to word, and are
best used as paragraph text.
A sans-serif font doesn't have serifs (for those of you spared the joys of learning French,
note that sans means without) and creates a somewhat more modern look. Examples
include Arial, Helvetica, and Verdana.
Sans-serif fonts are best used for short phrases or groups of text, such as headers or links. Serif
fonts tend to be used for paragraphs. Figure 2-5 gives an example of how this would look on a web
page.
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With thin lines, a cool touchpad
design, and a sleek,
touch-control panel, this 7.0 lb.,
15.4" laptop PC redefines
simplicity. In addition to being
ultra stylish, the PCs in the
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From software, memory, and
cards to carrying cases and
docks, look to HP for all the
accessories you need to make
your notebook PC more suited
to your personal needs.

Figure 2-5: Example of serif and sans-serif fonts on a website.
As is typical on the web, you can break the rules a little bit. Using Arial for both headers and text
would be fine as long as the headers are sufficiently larger than the text (to clearly differentiate
them). It might not be as visually interesting as mixing it up a bit more, though.

When you need a third style
On the web, there are page elements other than just headers and text, such as site navigation,
sidebars, and/or pop-up windows. You want to use another font, or at least another style, to
differentiate these areas from the rest of the page.
How to do this is partly a judgment call, but a good rule to remember is, if you're going to make it
different, be sure to make it significantly different rather than slightly different. For example, if you're
creating a sidebar for the style in Figure 2-5, you could make it Arial, but bold and green.
You can also differentiate special areas from the rest of the page using background colors.

Size matters
Another case in which to keep the make-it-significantly-different rule in mind is when creating
various levels of headers. Your second-level header should be sufficiently smaller than your
top-level header so users can notice the difference. When deciding on heading sizes, view your
page in several different browsers to see whether it works.
Now you know how to use colors and fonts on your website. The next step is to add images to
enhance your message. Pick up some tips for using images wisely on your website in the next
section.

Use images wisely
Unless your site is purely technical, with no commercial or personal interest (the W3C website, for
example), you want to use images to make it visually interesting. Images can help convey moods
and ideas not easily described in words. They can also help users understand how to use the site.

» Desktop storage

Convey ideas with images
Say you own a miniature golf course, and you'd like to create a promotional website that encourages
families to come out and play a round at your course. A good image to use might be one of a family
playing miniature golf, laughing, and having a good time. This image conveys the feeling of fun and
family bonding, without you actually putting the words "Fun and Family Bonding!" on the site.
Selecting an image to convey a feeling can be as straightforward as putting a big, juicy-looking
orange on an orange juice website. Despite the fact that any visitor would already know that the site
was about orange juice, the image of the big, juicy orange is a more positive and emotional way of
getting the user engaged in the site. Putting the words "Yummy Orange Juice" in huge text across
the homepage just wouldn't have the same effect.

Whether you want to back up
your personal media and data
for safety's sake or clear up
your hard drive to make space,
look to HP for your storage
needs.

On the other hand, some sites call for more subtle use of images to convey a feeling. For instance,
many websites for funeral homes feature photographs or sketches of the funeral home or its
employees. Both convey a feeling of reassurance to the potential customer. The funeral homes look
invariably spotless, and the employees invariably respectful and professional.

» Notebook storage

Helping users get around with images
Images are often used on websites to help users figure out what to do. For instance, a picture of a
pencil could indicate that a user can write to the webmaster by clicking there. Or an image of a
cloud with the sun peeking out might indicate that weather information is available by clicking. One
of the most ubiquitous images is a question mark, where a user can click for help.
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Such images, called icons, are often used together with text to guide users. For example, if you visit
any of the numerous travel sites, such as Expedia, shown in Figure 2-6, you might see an image of
an airplane and the word flights to let the user know this is a link to the Flights section of the site.
Both visual and literal people are served by using both.

Whether you need storage to
back up your important
memories and data or to clear
up space on your hard drive,
HP notebook storage cards and
devices are designed to meet
your specific needs.

Figure 2-6: Icons help visitors visually identify links and information.
Enlarge image
Children's sites often use simply images as a navigation tool, partly because small children may not
be good readers, and also because children enjoy more colorful media. Take a look at the
instructions for a game on SesameStreet.com in Figure 2-7. The instructions for the visitor consist
primarily of images.

Figure 2-7: SesameStreet.com uses images to help kids use the site.
Enlarge image
Images convey a lot of information about a site and should be chosen carefully. There are a
seemingly infinite number of images to choose from, so the next step is to cull through them to find
images that best suit your needs.

But how do I find images to use on my website?
One of the trickier tasks in website development is collecting appropriate images to use on your
website. Assuming you don't have a big graphics budget, you'll be doing some scrounging to come
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up with good material.
Don't steal images. Ah, there are so many sites out there with so many beautiful images. But
they're not there for the picking. Although it's simple to download an image from someone else's
website, you shouldn't do it, at least not for use on your own website.
There are three main sources of images:
Copyrighted images you can get for free
Copyrighted images you must buy
Images that you create and own the copyright to
First, we'll explain a bit about copyrights. When you create something, you own it. No one else can
use it unless they obtain permission to use it, or purchase rights to the item from you. Even though
a site might not contain a copyright notice, assume that everything used on someone else's site is
copyrighted. Whoever owns the site always owns all the words and all the images on the site
(unless they stole the images -- or the text -- from someone else). This means that you risk legal
problems, and sleepless nights, if you copy any part of the site.

Freebies
So what can you do if you're a terrible artist but you still want to jazz up your site with pretty
pictures?

Get premium performance and
maximum expandability with our
Pavilion Elite d5000t ATX
series. With quad-core
processor technology and
discrete graphics on a full ATX
motherboard, this dynamic PC
will meet your most demanding
business and entertainment
needs. Note: this series is only
available online.
» HP monitors

Most word processors, desktop publishing software, and image processing software applications
come with a wide variety of free images. In Microsoft Word, for example, click Insert > Picture >
Clip Art. Use the Microsoft Clip Art Organizer, shown in Figure 2-8, to organize all the clip art,
pictures, sounds, and videos on your computer into one collection for easy viewing and selecting.

Find state of the art displays
from HP with excellent picture
quality in stylish designs.

Figure 2-8: Clip Art Organizer helps you organize pictures and media files.
Enlarge image

Royalty-free artwork
Another option is to use royalty-free artwork. A royalty is the fee you pay the owner of a copyright to
use the copyrighted item, each time you use it. Royalty-free means that instead of having to pay a
fee each time you use the image, you can pay a flat fee once, and be able to use the image
repeatedly. There are two ways to get images royalty-free:
You can purchase CD-ROMs that contain thousands of royalty-free images. Check out your
local, large office supply stores to see what's available. Be sure to check for legal notices on
those CDs. There may be limits on what you can use the image for -- for example, use may
be limited to schools and non-profit organizations.
There are a bunch of places on the web to download royalty-free art, for a fee. One of the
best values is iStockphoto. You should also visit the GettyImages, Corbis, and Clipart.com
websites. Or you can google royalty free art, copyright free art, or simply free art.
No matter where you buy get your artwork and images, make sure you read the fine print and the
restrictions on use. Most royalty free work is available for use on a public website but sometimes
they restrict use on business or e-commerce sites.
To clip art or not to clip art
Clip art is a mixed blessing. You'll find lots of it on the web or on inexpensive CDs, and you'll
probably find images that express the idea you want to get across with your website. The trouble is
that clip art images are simple line drawings, and as such they don't always convey the professional
message a site designer needs.
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When considering clip art, look at a lot of it before you make a choice. Pick the best images that
express the ideas you want, and be careful not to overuse clip art, or any kind of graphics, on your
site. Discretion in the use of graphics prevents your page from looking cluttered.
Why use photographs rather than clip art?
Although a great deal of the royalty-free images available on the web consists of clip art, there are
also many photographs and other high-quality images on the web, particularly through iStockphoto,
GettyImages, and Corbis. Because photographs usually look better than clip art, it's worth
considering these images for your web pages.
On the downside, photos almost always require more disk space than clip art images do. This
means that pages containing photographs usually take longer to download than pages with clip art -especially if you use multiple photos on a page. That's not a fatal problem by any means, because
more people are switching to broadband, which means download times are less of an issue. You
can easily compress photographic images (and clip art, too). You'll learn about these techniques in
Lesson 3.
If you've got a camera and a good eye, you can forgo searching for images altogether. In the next
section, you'll learn how to create your own images.

Use original images
Freebies aside, there's nothing quite like custom-made graphics. That's where a graphic designer
comes in. Designers can advise you about the best look for your site as a whole, and can create the
kind of images for you that enhance its appearance significantly. Of course, you have to pay for their
services, but sometimes it's really worth it.

» Norton Internet Security
2008

If you have a bit of talent, you might want to take a course in digital design and learn how to think
like a designer when approaching your website. You also learn how to use software tools that can
help you create your own artwork.

Photography with digital cameras
The advent of digital cameras has made taking and uploading pictures to the web rather simple.
These days, most digital cameras take great pictures and come with software that makes
transferring the photos to your desktop a piece of cake.
Many graphics applications include a nifty tool that allows you to import digital camera images
directly into the program via a plug-in. A plug-in (in a graphics application) is software that enables
you to manipulate a specific camera or scanner within the application. In some cases, plug-ins are
bundled with the application. In other cases, you need to install a plug-in for the camera or scanner
you're working with. That software comes with the camera or scanner, which also includes
instructions for installing it.
When using a digital camera, take the pictures at the highest resolution you can. This will give
you more flexibility when working with your images later.

Travel the Internet while
protected against viruses,
hackers, spyware, and spam.
Stay safe as you e-mail, swap
files, download programs, and
chat. You're automatically
protected when you've got
Norton Internet Security 2008,
updated and enhanced with
more features than ever.
» HP Total Care owner
services

Film cameras work, too
If you don't have a digital camera, just how can you get your photographs into your computer? You
can still use your regular camera. Take the pictures, but instead of getting paper prints, get your
pictures saved to CD-ROM.
Kodak pioneered the concept of processing photographs to a CD-ROM, and this service is available
at most photo counters. It's also available on the web through such services as Shutterfly and
Snapfish.
These services also publish your photos directly to the web, usually at little or no cost above film
processing. You send them your film and get hard copy photos and a downloadable file of the film
roll online. Once you're notified that your photos are available online, all you have to do is surf to the
site, view your images, and then download them to your computer.

Protect your investment and
achieve greater peace of mind
with the right HP Extended
Service Plan for your needs.

Drawing on the computer
If you have very good mouse-hand-screen-eye coordination, or have an electronic drawing pad, you
might want to try drawing your own art on your computer. Microsoft Office comes with Paint, a basic
drawing program that saves images in a variety of formats.
See Lesson 3 for more information on web-ready file formats.
More sophisticated drawing programs include Adobe Illustrator and CorelDRAW. These programs
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require an investment of cold, hard cash, but it's worth it if you're interested in creating your own
graphics. Download trial versions to compare the programs and pick the one that best suits you.
No matter where you decide to go for graphics for your website, the most important factor of all is
that they add value to the site, not detract from what you're trying to accomplish. Not only do you
want your site to be clear and professional looking, you want it to be easy to navigate and use. In
the next section, you'll learn about usability and accessibility, and how to make your site meets
these ideals.

Usability and accessibility
In the last few years, the concepts of usability and accessibility have become ever more important to
web design. To make your site friendly to everyone who visits, it's important to keep both of these
concepts in mind, and put them into practice as much as possible.

» Desktop PCs

Usability
Usability is the technique of making something (in this case, a website) as easy to use as possible,
so visitors can accomplish what they want in as little time as possible. There are a vast number of
techniques to achieve usability, and we'll go over the basics here.
Don't get clever
Marketing people may get miffed when we say this, but overly clever names for the sections and
links on your website are not a good idea Whenever possible, use terms that reflect what the user
will experience or is looking for. Instead of saying "Vision," use a phrase such as "What We Do."
Using color as a guide
If you're building a large site with many sections, consider color-coding the sections. Color-coding
helps visitors stay aware of where they are on the site and alerts them if they inadvertently switch to
another section.

View our wide selection of
desktop PCs to see reliable HP
quality at a great value. We'll
even help you choose the right
desktop for your unique needs.
» Desktop PC accessories

Don't be afraid to use white
Make your text easy to read by sticking to black text on a white background as much as possible.
Sometimes, to set a section apart from the rest of the web page, you'll want to use a light
background color. That's okay, as long as it's light enough to still be readable. White text on a black
background is also fairly easily read.
Do your homework
It pays to find out more about usability. Check out the following websites to solidify your knowledge:
Usability.gov
Usability First
A lot of sites are dedicated to this theme -- use your favorite search engine to find more.

From software and storage to
cables, mice, and keyboards, all
the accessories you need for
your HP desktop PC are
available to make your desktop
experience more personal,
powerful, and attuned to your
specific needs.

Accessibility
Accessibility is the practice of making your website as usable as possible for people with
disabilities. There are quite a few tools available these days to help people with disabilities use the
web. Just a few tricks will make your site much friendlier to these tools.
Alt-text, alt-text, alt-text
Every image you use on the web has the option of showing alternate text, or alt-text. This was
originally developed because in the olden days some browsers could not display images, and some
people set their browsers to not load images to save download time. Nowadays, there are web
navigation tools for vision-impaired people that actually read the contents of your site to the user. If
there is no alternate text for your images, these visitors will have no idea what the image is. Even
worse, if you're using images for your navigation buttons, the user won't be able to navigate the site
without alternate text. It's quick and painless, so be sure to include it.
Avoid image maps
Image maps are images where certain parts of the image are clickable and linked to other parts of
the website. These are difficult for accessibility tools to interpret, so it's best to avoid them. If they
must be used, be sure to include the same links as regular text links on the same web page.
Learn more
A quick search on the web leads you to a wealth of resources on website accessibility. You can also
check out these websites for more information:
Section 508
Web Accessibility Initiative
Dive Into Accessibility
Be sure to read up on this subject before you get too deep into your website construction. If you plan
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for an accessible site from the beginning, you'll save yourself a lot of trouble down the road.

Next up
You've learned how to use colors, fonts, and image to create a great website design, and now it's
time to put your ideas and design together to actually create your first website. First, though, try your
hand at the quiz and assignment to make sure it all sank in. And don't forget to visit the Message
Board to swap web design ideas with your classmates and instructor.

Congratulations on completing the lesson! Don't forget the following:
» Assignment: Get started with your own design
» Quiz: Lesson 2, quiz 1
» Discuss what you've learned with your instructor and other students
» Return to the lessons list to get a quick overview of the entire class

Privacy statement

Using this site means you accept its terms

Feedback to Home & Home Office

© 2008 Hewlett-Packard Company, L.P.
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Web design basics assignment
Assignments are designed to help you apply the information learned in the lessons.
Get started with your own design
1. Using a color wheel or Color Schemer Online, develop three potential color schemes
for your website.
2. Choose the color scheme that seems most appropriate for your site. Decide which
colors are the main colors and which are second-level colors.
3. Visit the iStockphoto website and use the search function to find three graphics that
convey an idea that you want to include in your website.
You have completed this assignment.

Privacy statement

Using this site means you accept its terms

Feedback to Home & Home Office
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Lesson 2, quiz 1
Quiz: Lesson 2, quiz 1
Quizzes are designed to give you a chance to test your knowledge.
Please feel free to take this quiz again. We will update your score.

1. Where do you usually place logos on a web page?
A.

Top middle of page

B.

Bottom middle of page

C.

Top left of page

D.

Bottom right of page

2. True or False: Triad colors are three colors that are equidistant from one another on a color wheel.
A.

True

B.

False

3. True or False: Sans-serif fonts have small decorative lines on each letter.
A.

True

B.

False

4. True or False: To use royalty-free artwork, you must pay a small fee each time you use it.
A.

True

B.

False

5. True or False: To make digital pictures, you have to use a digital camera.
A.

True

B.

False

6. How do you ensure that accessibility tools can understand images?
A.

By providing alternate text

B.

By including a detailed explanation in plain text

C.

By including audio with every image

D.

It's impossible -- don't use images if you want accessibility tools to understand your website

Privacy statement

Using this site means you accept its terms

Feedback to Home & Home Office
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» Contact HP

Phone orders 1-877-801-7183

Search:
Home & Home Office

All of HP United States

Lesson 2, quiz 1
» Home & Home Office
My Cart
0 items in My Cart

Quiz: Lesson 2, quiz 1
Quizzes are designed to give you a chance to test your knowledge.
Please feel free to take this quiz again. We will update your score.

Hello, Truitt
» Edit profile
» Sign out
» Online classes
» Your classes
» Contact us
» FAQ
»
»
»
»
»

Digital Photography
Everyday Printing
PC Learning Center
Digital Entertainment
Activity Center

Browse & Buy
» Home & Home Office
Store
» Find a retailer
» Rebate Center
Product Support
» Support &
troubleshooting
» Software & Drivers
» HP Total Care
» Register your product

Quiz Results
1. Where do you usually place logos on a web page?
A.

Top middle of page

B.

Bottom middle of page

C.

Top left of page

D.

Bottom right of page

Correct answer(s): C
Explanation:
You usually place logos in the top-left corner of a web page.

2. True or False: Triad colors are three colors that are equidistant from one another on a color wheel.
A.

True

B.

False

Correct answer(s): A
Explanation:
Triad colors are three colors that are equidistant from one another on a color wheel.

3. True or False: Sans-serif fonts have small decorative lines on each letter.
A.

True

B.

False

Correct answer(s): B
Explanation:
Serif fonts have the small decorative lines, sans-serif fonts do not.

4. True or False: To use royalty-free artwork, you must pay a small fee each time you use it.
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A.

True

B.

False

Correct answer(s): B
Explanation:
Most royalty-free artwork requires a one-time payment.

5. True or False: To make digital pictures, you have to use a digital camera.
A.

True

B.

False

Correct answer(s): B
Explanation:
You can convert regular film into digital pictures using a scanner.

6. How do you ensure that accessibility tools can understand images?
A.

By providing alternate text

B.

By including a detailed explanation in plain text

C.

By including audio with every image
It's impossible -- don't use images if you want accessibility tools to understand your
website

D.

Correct answer(s): A
Explanation:
Providing alternate text allows an image to be understood by accessibility tools.

You got 6 correct out of 6 questions.
Your Score: 100%

Printable version

Privacy statement

» Bookmark HP Online classes

Using this site means you accept its terms

Feedback to Home & Home Office
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Lessons - Plan and build your first website (with
podcast)
Plan and build your first website (with podcast)
» Lessons
» Message board

Welcome to your lessons. Some lessons may have quizzes or assignments for additional
learning. Don't forget to join your fellow classmates and instructor on the message board.

Lesson 3

» View single page

Web design tools make it easy
You've got your big idea. You've collected your content. You've planned your website structure. Now
it's time to put it all together. But wait! Just how are you going to do this?
If you don't know HTML, don't despair. There are plenty of web design tools available to create your
site. You've got a lot of choices:
Nvu: This freeware program is an easy-to-use, intuitive tool for beginners. What it lacks in
features and functionality, it makes up for in cost and ease of use. Perfect for a beginner and
a simple website.
Adobe Dreamweaver: Another web design product that experienced users swear by is Adobe
Dreamweaver. It's a little pricey at $399 for a new copy, but it produces very clean HTML
markup and is easy to use.
If you've used a word processor or desktop publishing software, adapting to a web design tool
won't be too difficult for you. For instance, to insert a table, you just click Table (or a similar
command) in the top toolbar. Same for images. Whichever tool you end up using, take the tutorial
to understand the basics.
Although your desktop publishing and word processing software often offer a way to convert from
document format to web format, don't use these tools for creating web pages. The HTML code
generated by this software tends to be full of random characters specific to the type of document it
was saved as originally and wreaks havoc with a variety of browsers.

Freebies (or at least a
month's trial)
A great way to determine
whether you like a product
before you buy it is to download
a trial version. Most of the
products mentioned in this
lesson have trial versions, so
you can get a feel for how the
product works and whether you
can work with it.
And then, there are always the
freebies. CNET's
Shareware.com is a repository
of millions of software titles.
Some are totally free and some
are available on a trial basis.
You might find a great tool
there. Also visit Download.com .
» HP Pavilion Elite m9300t
series

Do some research, download free trials to give you a chance to get to know each of the different
tools, examine your budget, and then decide on a web design tool and start using it. Your next step is
to select a graphics editing tool, and begin laying out your website template. That's coming up next.

With Intel's latest dual and quad
core processors, our Pavilion
Elite m9300t is ready for all your
digital adventures.
» HP monitors

Find state of the art displays
from HP with excellent picture
quality in stylish designs.
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Work with graphics
The web is nothing if not visual. In Lesson 2, you learned how to select appropriate images for your
site. Now you'll learn a number of ways you can create a visually pleasing website using a
combination of images and powerful tools.

» Desktop PCs

Select a graphics tool
A number of graphics tools are available that are geared specifically for web site development. This
is good news because more sophisticated programs such as Adobe Photoshop are rather expensive.
Two relatively low-cost web-oriented graphics tools are:
Adobe Fireworks: From the creators of Dreamweaver and Flash, this product is heavily
oriented toward website development, and makes it easy to create animations and image
maps. It even allows you to "slice" your design into web page components, generating HTML
automatically.
Corel Paint Shop Pro Photo X2: This image-editing software's web-specific tools include one
that optimizes your image in a particular format and a "slicing" tool.
Both of these products have a wide range of capabilities, including controlling brush size, applying
special effects such as textures and lighting effects, and font control. The more capabilities a
graphics program has, the more it costs (for example, Photoshop costs $650 retail) and the longer it
takes to learn. If you decide to make your career in the web business, by all means take the
professional route. For the rest of us, an easier, cheaper tool might be more what the doctor ordered.
As with your web design tool, try out some free trial versions to figure out which graphics tool you like
best.

Are your images web friendly?
Preparing images for the web is quite different from preparing images for print. So, if you've done
print publishing before, you may need to "unlearn what you have learned," as Yoda told Luke
Skywalker.
The web has rules for handling images. Basically, they are:
You should only use JPEG (Joint Photographic Experts Group) and GIF (Graphic
Interchange Format) images.
Your image should be as small (in bytes) as possible. The smaller the file, the faster it loads.
The resolution of your images should be 72 dpi (dots per inch).

View our wide selection of
desktop PCs to see reliable HP
quality at a great value. We'll
even help you choose the right
desktop for your unique needs.
» Desktop PC accessories

From software and storage to
cables, mice, and keyboards, all
the accessories you need for
your HP desktop PC are
available to make your desktop
experience more personal,
powerful, and attuned to your
specific needs.

Follow these simple rules and you shouldn't have any problems with download and pageload times.
Smaller is better
Both JPEG and GIF are compressed formats. This means that when you save anything in either
format, the resulting file is smaller than it would be if you had saved the same image in
uncompressed formats. By contrast, TIFF (Tagged Image File Format, which use the .tif extension) is
among the highest-quality image formats. This format is typically used to save images that ultimately
wind up in a printed publication.
GIF and JPEG are examples of two ways images can be compressed. The GIF format is excellent for
compressing images with relatively few colors or no gradations in color, because it reduces the size
of images by limiting the number of colors. The JPEG format reduces the quality of the image by
selectively discarding information about the image that the viewer is unlikely to notice. That's why
JPEG is best for compressing images with lots of colors. Drawings and clip art images make great
GIFs, whereas color photographs look best as JPEGs.
What does all this mean for you? You're going to have to spend a lot of time manipulating your
images. It's safe to say that you're probably going to spend more time fooling around with your
images than working on the formatting of associated text.
What's your DPI?
You'll find that a digitized image is often quite large -- so large, in fact, that it barely fits on your
monitor's screen. This is a good thing! When you shrink the image in your graphics application, you
also decrease its file size without compromising its quality. Most graphics software enable you to
choose new dimensions for an image.
When reviewing web development sites, you might come across the term ppi (pixels per inch).
For the purposes of this course, you can assume ppi and dpi mean roughly the same thing.
As mentioned earlier, images for the web should be saved at a resolution of 72 dpi. If you create
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images with a higher dpi, they may appear larger onscreen than you intend.
Nice proportions
Notice as you move around the web that images are usually proportional to the web design -- no
image is too big or too small. You might want to copy some of these images to your own computer.
Open some in your graphics software and note their dimensions. Pretty soon you'll have a good
sense of good image sizing parameters.
Take some time to play around with resizing your own images. Always resize them proportionally so
that when you change one dimension, the other is changed by the same percentage. You can use
HTML to choose size attributes for an image after you've placed it on a web page you're working on,
but the full-size image must still be downloaded when someone accesses your page. If you size the
image file itself before you add it to the page, it will be smaller to start with, and will download more
quickly.
Images add pizzazz to your website but also provide a good way to link pages to each other. In the
next section, learn about these links and how to connect pages to each other and other pages on the
web.

Links make the web go 'round
There would be no World Wide Web were it not for hyperlinks. In fact, hyperlinks (or just links) are
what make the web what it is: a worldwide network of interconnected documents.

» Norton Internet Security
2008

Link within your website
Links within your website are called internal links. For instance, all of your navigation items should
be internal links. You may want to link words or phrases in a text block to pages that have more
information on that word or phrase. You also may want to link an image displayed on a page to a
larger version of that image so users can see more detail if they choose.
Adding an internal link to a web page using a web design tool is pretty much the same procedure no
matter which program you've chosen. You'll need to highlight the text to be linked, or select the
image to be linked, and click the program's linking function. Then, you can use the tool to navigate to
the HTML file or image that the link should go to. The web design tool will create the proper link
automatically.
Be sure to read your web design tool's manual and take any tutorials to make sure that you
understand how to use your specific web design tool's linking function.
Create a website map
Another way that internal links are used is in the creation of a site map. A site map, as you learned
in Lesson 1, is a listing of all of the pages or (for larger sites) all of the sections of your website. Each
page or section listed on the site map is linked to the actual page or section. It's usually presented
hierarchically, such as on the Apple website.

Travel the Internet while
protected against viruses,
hackers, spyware, and spam.
Stay safe as you e-mail, swap
files, download programs, and
chat. You're automatically
protected when you've got
Norton Internet Security 2008,
updated and enhanced with
more features than ever.
» HP Total Care owner
services

Site maps are helpful when having your site added to a search engine. You'll learn more about
this in Lesson 6.
For a better sense of how pages are linked together on other sites, look for site map sections of
some of your favorite websites while you're browsing the web.

Link to other websites
The spirit of the web is one of interconnectedness. As the title of this page says, "Links make the
web go 'round." And in that spirit, you should have links on your site to other websites. Some ways to
use external links on your site are:

Protect your investment and
achieve greater peace of mind
with the right HP Extended
Service Plan for your needs.

Linking words or phrases in your site's text to websites with more information on that topic.
Adding a list of resources on other websites related to a particular topic or topics covered on
your website (and linking the items in the list, of course!).
Creating a special web page on your site that lists related websites. If you're creating a
personal site, it may just be a list of "websites That I Like."
Adding an external link to your site is pretty similar to adding an internal link. In your web design tool,
highlight or select the text or image to be linked, and click the program's linking function. In the text
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box provided, type the entire URL (Uniform Resource Locator, or web address) of the page you're
linking to, such as http://www.google.com or something more specific, such as
http://autos.netscape.com/?gname=uglycar.
Use links to lay out how your website is going to flow. Be sure to think about how a visitor is going to
want to intuitively go through the site gathering information, making decisions about which product
makes the most sense for them, and then moving on to make a purchase. If you link your pages
together intuitively, visitors will be more likely to feel good about your site and come back for more. In
the next section, you'll learn how to preview your website to make sure everything is working and the
visitor's path through the site makes sense.

Preview your website
As you develop your website, take a look at your web pages in a web browser to make sure they're
looking good. It's best to do this locally (in other words, on your own computer) before uploading to
the Internet.

» Notebook PCs

To make sure you're on the right track, all you need is your browser. Then follow these steps:
1. Create a new directory on your computer and name it something relevant to this project (for
example, newweb or My First Website).
2. Save your web files to this directory, including all HTML files and graphics.
3. Once you have at least one file in this directory, open a web browser, such as Microsoft
Internet Explorer or Mozilla Firefox, and type the path and directory name in the browser's
address field. No need to add http://. Just type c:\newweb, or, if you're using a Mac, your
hard drive's name, a forward slash (/), and the directory name (newweb). You can also use
the Browse feature to find your directory. You'll get a listing of what's in that directory, as
shown in Figure 3-1.

HP makes it easy to go
wireless. Our notebooks are
light, powerful, durable...and
surprisingly affordable.
» Notebook PC accessories

From software, memory, and
cards to carrying cases and
docks, look to HP for all the
accessories you need to make
your notebook PC more suited
to your personal needs.

Figure 3-1: You can open your web design folder using your browser.
Enlarge image
4. Double-click any of the HTML files to display it in your browser.
Most web design programs help you develop your website structure automatically. They also
typically have a Preview tool that shows your web pages in a browser.
That's all there is to using your own computer and browser to test your web designs.

How'd they do that?
Like most web developers, you've probably spent a lot of time browsing other people's websites, and
getting ideas of what you like, and don't like, and what you want to do on your own site. But
sometimes you may not know how to do what you want.
There are a few ways to find out. First, you can contact the website owner and ask them. Second,
you can use the View > Source option in your browser to take a look at the HTML. Or, third, you can
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download the web page to your local computer and take a look at in your web design tool.
You need to get permission to use someone else's proprietary web program. However, grabbing
HTML or JavaScript code that you aren't yet familiar with is not a problem.
Save pages from the web
Log on to the Internet and go to any website. Save that page in your web design directory or folder
using the browser's File > Save As command. Now point your web browser to your web design
directory and open the HTML file you just saved. What happens? Does the page display as it did
when you opened the page from its http address? Are things missing?
Unless you've downloaded a very plain web page, the page will be missing images and maybe its
font styles. To download every file associated with a web page, select File > Save As and then
select Web Page, complete (or something similar) in the Save as type drop-down list to save the
entire web page, including all graphics. Internet Explorer creates a series of subdirectories within the
directory you created to store these images and other web page items. Select File > Save As and
then select Web Page, HTML only to save only the text.
Save Images from the web
Just want to save a website's images? Taking and using anything from other people's websites,
including images, might be in violation of copyright laws. However, if you just want to copy an image
from another website to view it, or if you're sure there are no copyright issues, place your cursor over
the image and right-click the mouse button. Select Save Picture As from the shortcut menu. In the
Save Picture dialog, save the image into your web design directory. Mac users can click and hold the
graphic, and then select Download image to disk from the menu.

Next up
Now that you've learned how to put it all together, in Lesson 4, you learn how to give your website a
home on the web (no, not on the range). But first, complete this lesson's quiz and assignment to
solidify your new knowledge. After that, pop in at the Message Board to see what your classmates
are saying about their web design tools.

Congratulations on completing the lesson! Don't forget the following:
» Assignment: Add some elements to your site
» Quiz: Lesson 3, quiz 1
» Discuss what you've learned with your instructor and other students
» Return to the lessons list to get a quick overview of the entire class

Privacy statement

Using this site means you accept its terms

Feedback to Home & Home Office

© 2008 Hewlett-Packard Company, L.P.
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Putting it all together assignment
Assignments are designed to help you apply the information learned in the lessons.
Add some elements to your site
1. Download the latest version of Nvu (if you don't already have it).
2. Use Nvu to design the framework of your website -- that is, the title or logo, navigation,
and body area elements. Add an image or two as well.
3. Save the web page you've created in Nvu and preview it in Microsoft Internet Explorer
(select File > Open or CTRL+O to open the web page you just created).
What do you think? What would you like to change? Share your experience with your
classmates and instructor on the Message Board.
You have completed this assignment.

Privacy statement

Using this site means you accept its terms

Feedback to Home & Home Office

© 2008 Hewlett-Packard Company, L.P.

10/23/2008 10:37 AM

HP Online classes - Lesson 3, quiz 1

1 of 1

http://h30240.www3.hp.com/sessions/lessons/viewQuiz.jsp?courseSessio...

Lesson 3, quiz 1
Quiz: Lesson 3, quiz 1
Quizzes are designed to give you a chance to test your knowledge.
Please feel free to take this quiz again. We will update your score.

1. True or False: You should use word processing software to develop pages for your website.
A.

True

B.

False

2. What are the two web-friendly image formats? (Check all that apply.)
A.

PNG

B.

GIF

C.

TIF

D.

JPEG

3. JPEG images used on the web should have a resolution of _______ dpi.
A.

240

B.

72

C.

16

D.

512

4. What do internal links link to?
A.

Other pages on your website

B.

Pages on other websites

C.

Search engine pages

D.

Graphics files on other websites

Privacy statement
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» Contact HP

Phone orders 1-877-801-7183

Search:
Home & Home Office

All of HP United States

Lesson 3, quiz 1
» Home & Home Office
My Cart
0 items in My Cart

Quiz: Lesson 3, quiz 1
Quizzes are designed to give you a chance to test your knowledge.
Please feel free to take this quiz again. We will update your score.

Hello, Truitt
» Edit profile
» Sign out
» Online classes
» Your classes
» Contact us
» FAQ
»
»
»
»
»

Digital Photography
Everyday Printing
PC Learning Center
Digital Entertainment
Activity Center

Browse & Buy
» Home & Home Office
Store
» Find a retailer
» Rebate Center
Product Support
» Support &
troubleshooting
» Software & Drivers
» HP Total Care
» Register your product

Quiz Results
1. True or False: You should use word processing software to develop pages for your website.
A.

True

B.

False

Correct answer(s): B
Explanation:
Word processing and desktop publishing software add a lot of random characters to their HTML code,
which can cause problems when creating web pages.

2. What are the two web-friendly image formats? (Check all that apply.)
A.

PNG

B.

GIF

C.

TIF

D.

JPEG

Correct answer(s): BD
Explanation:
The two web-friendly image formats are GIF and JPEG.

3. JPEG images used on the web should have a resolution of _______ dpi.
A.

240

B.

72

C.

16

D.

512

Correct answer(s): B
Explanation:
The optimal resolution for JPEG and GIF images is 72 dpi.
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4. What do internal links link to?
A.

Other pages on your website

B.

Pages on other websites

C.

Search engine pages

D.

Graphics files on other websites

Correct answer(s): A
Explanation:
Internal links connect pages on your website to one another.

You got 4 correct out of 4 questions.
Your Score: 100%

Printable version

Privacy statement

» Bookmark HP Online classes

Using this site means you accept its terms
© 2008 Hewlett-Packard Company, L.P.
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Lessons - Plan and build your first website (with
podcast)
Plan and build your first website (with podcast)
» Lessons
» Message board

Welcome to your lessons. Some lessons may have quizzes or assignments for additional
learning. Don't forget to join your fellow classmates and instructor on the message board.

Lesson 4

» View single page

Where is the web?
The Internet is a global network of computer networks that are all configured to communicate using
the same basic languages, or protocols. The key to its success is that it's highly distributed. There is
no place, or even center, of the Internet -- although there are several very important routes that you
can take through the Internet, which are called backbones.
Internet data travels over the existing public telecommunications network. Unlike phone calls or older
types of computer networks, a message sent through the Internet doesn't travel as a single piece.
Instead, it's broken up into packets that are individually routed to their destination and reassembled
when they get there. It's very similar to how transporting probably works on Star Trek. This flexible
routing ability is what makes the Internet so reliable. If you haven't been in a cave for the last decade,
you're probably also aware that the Internet was originally designed to be able to survive almost
anything. Even if the major Internet backbones were to disappear tomorrow, data would still find its
way around the Internet -- probably somewhat slower, though.
When we use the Internet, we're actually using Internet applications. The most popular of these are
e-mail and the web.

And your point is?
The reason for this brief detour into yet another explanation of the Internet and the web (which you
clearly understand well enough, since you're using it right now), is that you need to make your new
website a permanent fixture on it and you'll find out how to do that now.
Any computer that can use the basic Internet protocols can connect to the Internet and become a
part of it very easily. One way to publish your site is to install the necessary software on your home
computer, leave it connected to the Internet, and tell the world your Internet address (called an IP
address).
This is not the best way to publish your website, however, for a number of reasons, including:
Your ISP (Internet service provider) probably frowns on this, if it even allows it.
Unless you're using broadband service, such as DSL or a cable modem, your connection to
the Internet is likely too slow to provide a decent browsing experience for your visitors.
If you use a modem and a phone line to connect to the Internet, the line is always in use.
There are security hazards with opening your computer up to the Internet. By advertising your
website to the world, you open yourself to potential hacking of your computer. If you're not
trained to secure a web server, you should leave it to the professionals.

» Desktop storage

Whether you want to back up
your personal media and data
for safety's sake or clear up
your hard drive to make space,
look to HP for your storage
needs.
» Notebook storage

Whether you need storage to
back up your important
memories and data or to clear
up space on your hard drive,
HP notebook storage cards and
devices are designed to meet
your specific needs.

For these reasons (and several others), most people choose to outsource the hosting of their
website. Often, the easiest way to outsource web hosting is to use the same company that provides
you with access to the Internet, your ISP.
So how do you find a suitable ISP? Find out in the next section.

Tour ISP offerings
Not all computers on the Internet are created equally. Some of their connections are faster, making it
possible for these systems to handle a large amount of traffic, and to provide a gateway to the
Internet for computers with slower connections. An ISP has a very fast connection to the Internet and
is constantly connected to it.

» Compaq Presario CQ50Z
series

So, what is an ISP and what do they do? Basically, ISPs have big, fast computers that are equipped
to store e-mail and web pages, and even route Internet traffic from one place to another. These
computers are called servers. Figure 4-1 shows a birds-eye view of a portion of the Internet. Notice
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that the ISP acts as a gateway to enable you to connect to the Internet. ISPs also serve as access
points for other computers to connect to you -- either by routing e-mail to your computer, or by
allowing other people to view your website.

With thin lines, a cool touchpad
design, and a sleek,
touch-control panel, this 7.0 lb.,
15.4" laptop PC redefines
simplicity. In addition to being
ultra stylish, the PCs in the
Presario CQ50Z series are
durable, powerful, and
value-priced.
» Notebook PC accessories

Figure 4-1: A birds-eye view of a portion of the Internet.
ISPs come in many sizes: AOL is an ISP, and so are Road Runner, AT&T Yahoo!, Comcast,
Earthlink, and many others. Each offers different services and charges different prices, but all will get
you or your content onto the Internet.
Most ISPs also offer a service called web hosting. When you sign up for web hosting, you get
access to the ISP's web server, enabling you to transfer the web pages you've designed (including all
of your GIF, JPEG, and HTML files) to your ISP's faster machine. If you look again at Figure 4-1, you
can see how it works. You're sitting at one of the computers at the top of the picture. You design your
web pages from the comfort of your own home. When your design is finished, you transfer your
creation to the powerful hosting computer (server) at your ISP. It's from this location that anyone else
with a connection to the Internet can browse your content. It's simple, really.

From software, memory, and
cards to carrying cases and
docks, look to HP for all the
accessories you need to make
your notebook PC more suited
to your personal needs.

The first thing you have to do is find the ISP that's right for you. The following sections address
questions you should consider

Which services does the ISP offer?
Does the ISP offer the services you need today -- and in the future? Let's say you start with a simple
informational website. Most ISPs can do this at low cost -- all it takes is a small amount of server
space. But let's say that you're thinking about selling some stuff over the Internet during the next
year. This is known as e-commerce. Be sure your ISP offers the features you need. For instance,
some ISPs offer e-commerce packages that include a secure server, shopping carts, and credit card
processing. Although you could certainly change ISPs as your needs grow, it's usually best to find
and stick with one you like, and whose services can grow along with your needs.
Yahoo! Merchant Solutions offers several all-in-one e-commerce packages for individuals and
businesses. If you're more of a do-it-yourselfer, explore the PayPal Merchant Services web
pages to get information about incorporating PayPal Buy Now buttons and other shopping cart
tools into your website.

How many hops away from a backbone is your ISP?
Like you, most ISPs purchase their Internet connections from another company. The difference, of
course, is that they purchase much, much faster Internet connections. If your ISP's Internet
connection comes directly from one or more backbones, it's said to be one hop from the backbone.
Having an ISP that's connected directly to an Internet backbone reduces the total number of hops
that data needs to make to get to your computer, which increases the speed of your Internet
connection and the speed at which your website will download for other people.
How much do you want to pay?

2 of 8

10/23/2008 10:43 AM

HP Online classes - Lessons - Plan and build your first website (with pod...

http://h30240.www3.hp.com/sessions/lessons/viewLessonAllPages.jsp?c...

There are thousands of ISPs out there. They offer varying levels of service, features, and support for
varying price ranges. Some ISP services are even free. Once you determine which services you
need today, and which ones you might need in the future, visit several websites to learn about ISP
pricing. Find out what the market says the service you need is worth, and you'll probably find some
bargains, especially if you do your homework before you buy.

Which level of support do you need?
It is not be a good idea to sign up with an ISP based on price alone, especially if that ISP has a
reputation for poor service. Spend time at the ISP's website. What kind of support does it offer? Is
there an 800 number you can call if you run into problems? Is there a special e-mail address for
support? Does the ISP promise a response within 4 hours, 8 hours, 1 day, or 2 days? Ask your
friends or business associates which ISPs they've used, and how they felt about the support they
received.
Which extras does the ISP offer?
Some ISPs offer unlimited e-mail addresses. Some offer pre-built functionality to handle things such
as auctions, chat, blogs, and message boards. Make a list of what you want and try to find an ISP
that offers these options for little or no extra charge.
Do your homework. ISPs change their offerings, new ISPs appear, and pricing is constantly changing
due to market demands, so spend a little extra time understanding what you want and what's
available in your area before you make any decisions. Although it's easy to transfer a few simple web
pages and graphics files from one ISP to the next, transferring a larger site can be a hassle and
might cost you money you don't need to waste. Next, get some tips for doing the required homework
to find the right ISP.

Find the best ISP for you
So where can you go to get information about which ISP you should use? The web, of course:
The Listcontains a massive list of ISPs around the world. It's a particularly great resource if
you want to choose an ISP that's headquartered in your area. You can search by area code,
state, or country, and find lots of pricing information. You should, however, always verify
prices with each ISP you're considering.
WebHosters.comis an information-rich site with lots of information on different hosting
companies.
HostReview.comis another information-rich site providing details on various hosting
companies.
Search your local yellow pages and ask around to find out which ISP your friends and family use, as
well. There are a lot of local ISPs who do as good a job as the national services for the same price or
less.

Shop the specs
At this stage in your web design career, you're not actually going to understand all of the features you
see described on ISP sites. At a minimum, you're going to want the following features:
A minimum of 20 MB (megabytes) of disk space: You want a large chunk of space to store
your images, HTML files, and other content. The more, the better. Even if you're just getting
started and your web pages barely use a fraction of that space, if the price for 20 MB of disk
space is the same as the price for 5 MB, go with more space.
One GB of data transfers per month: One GB is one billion bytes. Wow! Data transfer
means the movement of bytes to and from your website. When a visitor downloads a page
(and any associated images or multimedia files), the amount of data transferred is added to
your tally for the month. Some web hosting companies charge you for data transfers
exceeding a certain number of MB.
FTP access to your account: FTP stands for File Transfer Protocol. You'll learn about FTP
in-depth later in this lesson. For now, it's sufficient to say you need this to move (upload) your
content from your PC or Mac to the hosting computer.
E-mail: Make sure your account with an ISP includes e-mail, and that you can pick up your
mail from the ISP's mail server directly. In addition, you want as many e-mail addresses as
possible. You've probably noticed that many sites use an info@ mywebsite .com address,
along with others for sales, jobs, etc. Of course, you'll want an address for each person
associated with your site, too.

Beware the freebies
Don't be tempted by all those
offers of free websites. They are
indeed free but generally such
sites often come with strings
attached, and do not allow you
to use your own domain name.
Use these sites for personal
pages and unlimited free
practice if you need it. For your
professional projects, do your
users a favor and make the
investment of a more
professional solution.
» Norton Internet Security
2008

Travel the Internet while
protected against viruses,
hackers, spyware, and spam.
Stay safe as you e-mail, swap
files, download programs, and
chat. You're automatically
protected when you've got
Norton Internet Security 2008,
updated and enhanced with
more features than ever.

You should also have the ability to add interactive features to your site, and a toll-free, 24/7 tech
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support number and e-mail address. Make sure all this information is easy to find on your ISP's site.
Once you determine which ISP to contract with, it's time to decide on the name of your site. In the
next section, you'll learn how to find a good name and purchase an appropriate domain.

» HP Total Care owner
services

Protect your investment and
achieve greater peace of mind
with the right HP Extended
Service Plan for your needs.
www.icantbelieveitsmyfirstwebsite.com
If you plan to do any business on the web, you need your own domain. Many personal websites sport
URLs like this:
http://www.isp.com/mysite/home.html
Trips right off the tongue, doesn't it?
If your web URL is going to be memorable and easy to include in printed material, it should look more
like this:
http://www.wonderfulkites.com
The name you choose for your website is very important. It says a lot about who you are and what
you do. What you call your website depends on several things:
Your audience
What information you want to convey, or what you sell
Which domain names are available

Domain registration
logistics
It can take up to 72 hours for
your name to be available after
your ISP sends the forms to the
domain registry service. This
means you might get an error
message when you type www.
yourdomainname .com into your
browser. Your ISP will also give
you an IP address, which is a
set of numbers (for example,
209.55.67.12). You'll be able to
get to your website immediately
using this address.
» HP Pavilion Elite PCs

To get the domain name you want for your site, you must first register it, and then let your ISP know
that the domain is yours. Their techies do a little technical magic and, just like that, your site is live.
Your job is to add content.

Determine your audience and market
You can register as many domains as you have money to pay for, assuming that someone else has
not claimed them. This means that you're going to have to spend considerable time thinking of
names, and then checking to see whether they're already in use.
The first step in thinking up a name is to decide who your audience is. Is it the teen market? The
business market? The sports market? After you know whom you want to reach, think about exactly
what you want to market. For example, let's say you're in the sporting goods business and know your
audience is sports fanatics. Let's also say you specialize in volleyballs. The next step is to come up
one or more names that "sell" directly to that market. You have several choices:
Come up with a name, such as www.volleyballs.com, that's an exact match to your market.
The value of this approach is that your domain name is the same name as the market. It's
easy to remember and, more than likely, the first word someone will type into a search engine
when searching for volleyballs.

The next generation of home
entertainment; access TV,
movies, music and photos,
when and how you want.
» HP w2207 22-inch
widescreen flat-panel
monitor

Unfortunately, given the proliferation of websites, most simple and easy-to-remember domain
names are no longer available.
Choose a domain name that's similar to the name of your company, but that complies with
the rules for domain names. For example, if your company is ABC Volleyballs, Inc., you might
register abcvolleyballs.com to use for your site.
Get radical. Try a name that's so unusual sounding that it gets noticed right away. For
example, www.monster.com does not sell monsters -- it's a job search service. The
www.google.com website is a search engine, and www.amazon.com is based in Seattle,
which is nowhere near Brazil.
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Whether you go conservative or highly creative, there are a few hard and fast rules you need to
follow when choosing a domain name.

excellent picture quality and
flexibility for sensational
viewing.

Know the domain name rules
There are certain restrictions on which characters and how many characters can be in a domain
name. In addition, certain types of domains have restrictions or recommendations (rules that aren't
mandatory) on who can register them. Here are the most common rules:
Use only letters, numbers, or hyphens (-)
The URL cannot begin or end with a hyphen
It must have less than 63 characters, not including .com, .net, and .org
.com domains are for commercial and personal sites
.net domains are recommended for companies involved in Internet infrastructure (such as
ISPs)
.org domains are recommended for not-for-profit organizations
Other domain types include .gov (government), .edu (education), and a plethora of foreign country
abbreviations (uk, .jp, .au, and .ca). To register some of these types of domains (such as .gov and
.edu), you have to actually prove that you're an educational or governmental institution. For .net,
.com, .org, and the newer domains (such as .biz, .info, and .name), you only need to pay the fee to
register.
Make a list of potential domain name candidates and ask your friends or family their opinions on
each. When you get it narrowed down to two or three top choices, you're ready to figure out if they're
available.

Find your perfect domain
The best way to search for a great name for your website is to spend a few minutes searching one of
the domain registry sites to make sure your great name hasn't already been taken.
ICANN (Internet Corporation for Assigned Names and Numbers) is charged with collecting fees and
keeping track of who owns what domain on the Internet. One of ICANN's functions is to accredit
domain name registrars, but there are many places where you can register that all-important name.
Network Solutions, shown in Figure 4-2, is a good first place to go to find out which domain names
are available. The site provides a nifty search tool -- Find A Domain -- that takes some of the pain out
of searching for an available and appropriate name.
However, it pays to shop around, as Network Solutions is not the least expensive option available for
domain registration.

Figure 4-2: NetworkSolutions.com is one of the ICANN accredited registrars.
Enlarge image
Let's give it a try. Go to the Network Solutions website and type wonderfulkites in the Find a
Domain text box. Notice the check boxes for selecting the type of domain you want. You can check
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as many of these as you like. There's no law or rule preventing commercial use of .org or the use of
.tv by a website that isn't based in Tuvalu.
Make sure .com is checked, at a minimum, and then click Search. The result appears in Figure 4-3,
and you're in luck! This name is available in a number of domains, including .com, .net, and .biz. If
you had found your domain name to be taken, you just search for your second choice, and then your
third, and so on, until you find a name that's available.

Figure 4-3: Use Network Solutions to determine if your desired domain name is available.
Enlarge image
If you're stubborn and you want your name and you want it bad, you can try tracking down the
current owner of the domain name and find out if the name is for sale. Many Internet domain
names are even auctioned. Sometimes, if you have a great name, people come right to you.
To find out who owns a particular name, use the Internet WHOIS service. You can surf to this
website directly from the Network Solutions site -- a link to WHOIS appears on the bottom navigation
bar. Enter the entire domain name, including the "www" portion -- for example, www.kites.com. You
get the name and address of the owner and the rest is just business as usual.
If you're stumped as to which domain to register, or if you're just bored, go to DeletedDomains.com,
where they keep track of all the domain names that people once registered but have allowed to
expire.
Once you have a domain selected and registered, you'll want to upload your web pages to the site. In
the next section, you'll learn how to use FTP to populate your new site.

Using FTP to upload to your website
When you sign up with an ISP, you're given access to a chunk of disk space on their server, where
you can store your images, HTML, and other files. Your next task is to get your site content from your
PC or Mac to the server.

» Desktop PCs

Some ISPs create easy-to-use procedures to assist inexperienced website owners with uploading
stuff to the web. We sometimes find that, in spite of their best intentions, these easy-to-use utilities
are anything but. Fortunately, the hard way is actually not that hard. Using FTP software, you can get
your stuff uploaded to a web server in no time at all.
A free, easy-to-use Windows-based utility called SmartFTP is shown in Figure 4-4. Mac users can
find similar functionality by using Fetch.
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desktop for your unique needs.
» Desktop PC accessories

From software and storage to
cables, mice, and keyboards, all
the accessories you need for
your HP desktop PC are
available to make your desktop
experience more personal,
powerful, and attuned to your
specific needs.

Figure 4-4: SmartFTP is a free Windows FTP client.
Enlarge image
If you don't already have an FTP client, download SmartFTP or Fetch now.

Get started
Before you can set up access to your web files on an ISP's server, you need to obtain some
information from the company hosting your site. You'll need to know the address of the server you'll
use, the directory into which your files will go, and a user name and password you can use to
connect to the server. This information is usually provided when your account is activated. If you
don't have it, call your ISP's tech support department or visit the ISP's website. You're looking for
information about FTP access to your web site files.
When you have this information, type it in to the appropriate boxes in the FTP client software,
including your user name and password, and it'll connect you automatically. Now you're ready to
upload.
To upload a file to your website using SmartFTP:
1. In the Folders pane in the top part of the SmartFTP window, select the FTP server folder you
want to transfer files to.
2. In the Transfer Queue pane at the bottom of the window, click the Open button. Select All
Files from the files of Type drop-down list, select your website files, and then click Open.
Click the Start button. Your files are copied to the server.
As your files transfer, SmartFTP displays their status.
3. After you've finished uploading, select File > Disconnect to log off your website, and then
select File > Exit to close SmartFTP.
It's usually a good idea to upload the files, keep your session active, and open your web browser to
see if you get what you expected. This way you can quickly make any needed changes, re-upload
the changed file, and check to see that everything looks okay.

Test your website
After you've uploaded your site to the server, expect errors. Nobody creates her first website in one
shot. Common problems you might find during testing are:
Missing images: You may have forgotten to upload the image, or linked it incorrectly in
HTML or the web page editor.
Your text is formatted incorrectly: You may have made a mistake in coding or formatting
your web page.
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The spacing of text or objects on the page is wrong: You may have misaligned
something or left out a paragraph or line break.
Hyperlinks don't work: A link may be wrong, or you may have neglected to upload the page
you linked to.
Before you go live, you should fully test each page of your website. To do this, first test it on your
computer by viewing the pages on your hard disk (locally) in a web browser. Better yet, view it in a
variety of browsers to ensure everything you've created is compatible with Microsoft Internet
Explorer, Netscape Browser, and Mozilla Firefox. Once you know everything looks good on your
computer, upload all files to your website and then test, test, and test again.

Now that you know the basics
In this lesson, you learned about the workings of the Internet and the web, you got some tips on
registering domain names, and you learned how to upload your website files to a server. At this point,
you should have a functioning site. Congratulations! Pat yourself on the back. If you're still not quite
there, take some time to visit the Message Board and get some tips from your instructor and
classmates.
If you think you've got the material down pat, take a stab at the quiz, exercise your new skills with the
end-of-lesson assignment, and visit the Message Board to show off your site.
When you're ready, proceed to Lesson 5 to learn different ways of integrating multimedia into your
website.

Congratulations on completing the lesson! Don't forget the following:
» Assignment: Post your site
» Quiz: Lesson 4, quiz 1
» Discuss what you've learned with your instructor and other students
» Return to the lessons list to get a quick overview of the entire class

Privacy statement

Using this site means you accept its terms

Feedback to Home & Home Office

© 2008 Hewlett-Packard Company, L.P.
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Give your website a home assignment
Assignments are designed to help you apply the information learned in the lessons.
Post your site
Finally, you're at the publishing stage in the course. Post your website and share the URL on
the Message Board. Let your classmates be your test audience. Let them know how you
created or obtained your graphics, and if there were any particular websites that inspired your
project or gave you helpful ideas. Also post any questions you have about your work ("How do
I make this image fit onscreen, change these colors, improve my download time?" and so on).
Be sure to visit your classmates' websites and give them helpful feedback, as well.
You have completed this assignment.

Privacy statement

Using this site means you accept its terms

Feedback to Home & Home Office

© 2008 Hewlett-Packard Company, L.P.
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Lesson 4, quiz 1
Quiz: Lesson 4, quiz 1
Quizzes are designed to give you a chance to test your knowledge.
Please feel free to take this quiz again. We will update your score.

1. True or False: For the best results, you should host your website on your own PC or server.
A.

True

B.

False

2. True or False: All ISPs are the same.
A.

True

B.

False

3. Not-for-profit organizations tend to use which type of domain?
A.

.gov

B.

.org

C.

.net

D.

.com

4. Which organization collects fees and keeps track of who owns what domain on the Internet?
A.

Network Solutions

B.

IBM

C.

ICANN

D.

IRS

5. If your ISP doesn't provide an easy way to upload your web files to its server, which type of software can you use?
A.

E-mail

B.

FTP

C.

Text editor

D.

Hyperlink detector

Privacy statement

Using this site means you accept its terms
© 2008 Hewlett-Packard Company, L.P.
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» Home & Home Office
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0 items in My Cart

Quiz: Lesson 4, quiz 1
Quizzes are designed to give you a chance to test your knowledge.
Please feel free to take this quiz again. We will update your score.

Hello, Truitt
» Edit profile
» Sign out
» Online classes
» Your classes
» Contact us
» FAQ
»
»
»
»
»

Digital Photography
Everyday Printing
PC Learning Center
Digital Entertainment
Activity Center

Browse & Buy
» Home & Home Office
Store
» Find a retailer
» Rebate Center
Product Support
» Support &
troubleshooting
» Software & Drivers
» HP Total Care
» Register your product

Quiz Results
1. True or False: For the best results, you should host your website on your own PC or server.
A.

True

B.

False

Correct answer(s): B
Explanation:
There are several reasons you don't necessarily have to use your own PC or server to host your
website. This is one case in which you might be better off seeking the help of a professional.

2. True or False: All ISPs are the same.
A.

True

B.

False

Correct answer(s): B
Explanation:
ISPs are all different. Shop around and compare before you select one to host your website.

3. Not-for-profit organizations tend to use which type of domain?
A.

.gov

B.

.org

C.

.net

D.

.com

Correct answer(s): B
Explanation:
The .org domain is recommended for not-for-profit organizations.

4. Which organization collects fees and keeps track of who owns what domain on the Internet?
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A.

Network Solutions

B.

IBM

C.

ICANN

D.

IRS

Correct answer(s): C
Explanation:
ICANN is responsible for collecting fees and keeping track of domain ownership, and accrediting
domain name registrars.

5. If your ISP doesn't provide an easy way to upload your web files to its server, which type of
software can you use?
A.

E-mail

B.

FTP

C.

Text editor

D.

Hyperlink detector

Correct answer(s): B
Explanation:
You can use FTP software to upload your files to your ISP's server.

You got 5 correct out of 5 questions.
Your Score: 100%

Printable version

Privacy statement
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Lessons - Plan and build your first website (with
podcast)
Plan and build your first website (with podcast)
» Lessons
» Message board

Welcome to your lessons. Some lessons may have quizzes or assignments for additional
learning. Don't forget to join your fellow classmates and instructor on the message board.

Lesson 5

» View single page

Decide when to use multimedia
Used correctly, audio and video can be effective tools for getting your message across on the web.
Used poorly, audio and video can actually drive visitors away and make people not want to return to
your website. You're much less likely to make a disastrous mistake if you keep the following three
things in mind:

» HP Pavilion Elite PCs

Your website's purpose (remember your mission statement from the first lesson?)
Your audience
The limitations of the web
For example, if you're a real estate agent, the purpose of your site might be to sell homes. To sell
homes, you need people to visit your site, see listings, and become interested enough in a particular
listing to contact you. To achieve this goal, you might decide that video clips of houses would be
helpful.
As mentioned in previous lessons, you need to be aware of how fast an Internet connection your
visitors are likely to have. In the case of a general-interest site, you have to assume the worst.
Although about 50 million homes and businesses in the United States have broadband Internet
access, it's still generally considered safe to design general-interest sites for a 56 Kbps (kilobits per
second) modem.

The next generation of home
entertainment; access TV,
movies, music and photos,
when and how you want.
» HP w2207 22-inch
widescreen flat-panel
monitor

In general, the broader your audience is, the more careful you need to be with using multimedia. On
the other hand, if you have a limited and homogenous group of people accessing your site (as in the
case of a company's internal website, or intranet), and if you know the speeds of their connections to
the site are not a factor, you can make more liberal use of multimedia.
Think carefully about your target audience and how they access the Internet before adding
multimedia to your website. A lot of companies currently track this subject, so google broadband
internet usage statistics to find the latest information on broadband usage rates. You can even
type in your state, region, or target audience (such as home buyers) to find targeted information
about usage rates. In the next section, you'll learn how to add audio to your site.

Ready to widen your
entertainment horizons? With
an impressive maximum
resolution of 1680 x 1050, our
w2207 22-inch Widescreen
Flat-Panel Monitor supplies
excellent picture quality and
flexibility for sensational
viewing.

Add audio to your website
As you browse the web, sometimes you come across a site that begins making noise as soon as you
load the page (of course, you need to have your speakers plugged in and the sound turned on).
Sometimes, you have to click a hyperlink to start the sound playing. That sound -- a person talking,
sound effects, or music -- is contained in an audio file.

» Desktop PCs

How do you add sound to a web page? You add an audio file the almost the same way as you add
an image file. Both image and audio files must be linked to a web page and activated with HTML.
The only difference is that instead of displaying a picture, an audio file plays a sound. Just as there
are web-friendly formats for image files (such as GIF and JPEG), there are also web-friendly formats
for different types of sound files. You find out about these throughout this lesson.
There are two ways to approach using audio on your site:
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Send information about the music (the notes, volumes, instruments, etc.) and let the receiving
computer's sound card play it.
Send the actual music as recorded audio.
The difference between the two ways of using sound boils down to what you want the sound to
accomplish on the web page. There are advantages and disadvantages to both types of web audio.
In the next sections, you'll learn about how to use both types, as well as the reasons for using one
over the other.

View our wide selection of
desktop PCs to see reliable HP
quality at a great value. We'll
even help you choose the right
desktop for your unique needs.
» Desktop PC accessories

Recorded audio on the web
High-quality audio files can be very large. The WAV format, which is used to store audio on Windows
computers, takes up about 10 MB of space for every minute of CD-quality, stereo sound. A typical
4-minute song, then, takes up 40 MB and would take about 90 minutes to download using a 56 Kbps
modem. No one, not even the drummer's girlfriend, is going to wait that long to hear a band's demo
song. So, what can you do?
Shrink it
There are several ways to reduce the size of digital audio files:
Use compression: Compression is an extremely effective way to dramatically reduce
multimedia file sizes while retaining quality. Compression uses what's called a codec to
strategically remove information from the file that's least likely to be noticed during playback.
MP3 is a codec.

From software and storage to
cables, mice, and keyboards, all
the accessories you need for
your HP desktop PC are
available to make your desktop
experience more personal,
powerful, and attuned to your
specific needs.

By converting a 4-minute WAV file to an MP3 file, you can reduce the file size by a factor of 10,
with no noticeable change in the quality.
Reduce the sampling rate: A simplified way of looking at sampling rate is as a
measurement of the quality of the audio. CD-quality sound has a sampling rate of 44 Khz
(kilohertz). Phonograph-quality sound is 22 Khz. Telephone-quality sound is 11 Khz. A
reduction in the sampling rate from 44 Khz to 22 Khz reduces the file size by half.
Convert it to mono: By converting your stereo audio file to mono, you chop the file size in
half. If you're planning to post a tape of yourself singing in the shower to your site, it'll
probably sound just as brilliant in mono as in stereo. This isn't the best solution to your band's
problem, however. In addition to making you sound worse, it still leaves you with a 20 MB file
and a 45-minute download.
By combining these different methods for reducing audio file size, you can easily shrink your 40 MB
audio file under 4 MB. Suddenly, the download time isn't all that bad. But, what do you do if you want
to post an entire concert, lecture, or any other lengthy audio file to your site? This is where a
technology called streaming comes in.
Stream it
Steaming means that when a visitor clicks a link to an audio file, the file isn't downloaded all at once
and then played, as is the case with a WAV or MP3 file. Instead of downloading the full sound file,
site visitors who click a link to stream content are able to listen to or view the file as it's downloading.
This creates the appearance of the download time being faster, even if it actually isn't. Pretty clever,
huh?
Streaming audio or video from the web can be somewhat more involved than simply providing files
for download. Streaming requires you to have access to a streaming server or software to prepare
your audio or video files for streaming (called an encoder ). When you upload files to a streaming
server, such as the one made by RealNetworks, it manages the process of sending it to users.
The actual process of using a streaming server is beyond the scope of this course; however, you
can learn about creating and using streaming media from Streamalot. The company includes a
number of short tutorials to help you set up specific types of streaming media.

The ultimate in small audio file sizes
Say you're creating a website for your wedding. When people visit the site, you want the wedding
march to play. Ignoring the corniness of this proposition, there are significant problems with using
recorded audio to accomplish this. The issue that you've already seen is the file size problem. If the
music plays every time someone visits the homepage, even a relatively small recorded audio file will
quickly become very annoying.
The solution is MIDI (Musical Instrument Digital Interface). MIDI is a standard for encoding
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information about digital audio. The important thing to remember about MIDI files is that they don't
actually contain the music. Instead, they tell computers how to play the music. Think of MIDI as sheet
music for computers. If the actual performance isn't important, and you don't need lyrics, MIDI is the
way to go.
To find MIDI files, simply search the web. There are hundreds of sites that give away free MIDI
music files.
See the following table to get an idea of how small MIDI files are in comparison to WAV and MP3
files.
Track Title

Format File Size

Take Five by The Dave Brubeck Quartet WAV

55 MB (56,320 KB)

MP3

5 MB (5,120 KB)

MIDI

15 KB

Table 5-1: Comparison of WAV, MP3, and MIDI file size.
Using recordings of someone else's works (such as Mr. Brubeck's) on your web site could
possibly be a violation of copyright law. Make sure that you have permission from the copyright
holder before making anyone else's material available on your site.
Although MIDI files are small and easy to find freely on the web, the sound quality of MIDI files
leaves a lot to be desired. Unless you absolutely have to have some sort of music load automatically
for visitors to your site, it's best to leave MIDI audio off.

Record on your PC
Microsoft includes a utility called Sound Recorder, shown in Figure 5-1. It's generally found in the
Accessories/Entertainment folder on Windows PCs.

Figure 5-1: Microsoft Sound Recorder.
Sound Recorder lets you play and record WAV files. You'll need a microphone to record sounds, and
speakers and a sound card to hear them. You can buy an inexpensive microphone at your local
computer retailer or electronics store. Be sure the one you buy has the same kind of connector your
computer does.
On the Macintosh, the Sound control panel has similar functionality to Sound Recorder.
The Sound Recorder and the Mac's Sound control panel work just as conventional tape recorders.
The red button is the record button, the square button is the stop button, and so on. You can tell right
away whether you're actually recording by the activity in the display.
After you've finished recording, you might notice that your WAV file includes dead air -- a few
seconds at the beginning or end of the recording. Sound Recorder provides a minimal editing
capability that lets you cut out parts of your WAV file. There's even some sound effects functionality.
If you're going to do any serious recording or sound editing as part of your web page development
process, you want to use a more robust sound-editing package, and quality recording equipment.
Another, more robust, sound editor is Audacity, which is free, and includes a host of editing features
that give you a lot of freedom and power to create and edit audio files.
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Add sound to a web page
After acquiring or creating sound files, it's time to add a link between your web page and the sounds
you want to play on it. Your web editor ought to be able to handle this task handily but you'll learn
some HTML code in this lesson to help you if you get stuck.
If all you want to do is allow your visitors to listen to a sound file if they choose, you simply link to a
sound files the same way you create any hyperlink. For example, to link the sound file
happy_birthday.wav to the text Happy Birthday, create this code in your HTML where you want the
link:
<a href="happy_birthday.wav">
Happy Birthday!</a>
That's all there is to it.
Now let's go one step further. Let's set up the page so that a WAV file plays when a visitor loads the
page.
<embed src="happy_birthday.wav"
width="144" height="60" autostart="true"
loop="true">
The height and width attributes are for the sound bar that's displayed when the sound starts using
the <embed> tag. The autostart attribute is self-evident and the loop attribute indicates to the
browser that the sound should be repeated over and over.
It's just that simple. Adding video can be a little more complex though. In the next section, you'll learn
the simple way to add video and discover where to go for more information about adding more
complex types of video.

Add video to your website
Adding video to your site is very similar to adding audio, and has the same potential drawbacks -only more of them. Whereas audio files can be large, video files are a whole lot larger. It's not only
the length of the video clip that increases file size, but the number of colors, the number of frames
within the clip, and the size of the images. It's not unusual for one-minute of compressed video to
gobble up 50 MB of disk space.
Consider that many folks surfing the web from home are still using a 56 Kbps modem. Now divide 50
MB (or roughly 50,000,000 bytes) by 56 KB (or roughly 5,600 bytes) and you can see how many
seconds it takes someone to download a video clip using conventional technology. If you don't feel
like doing the math, the answer is almost 9,000 seconds, or 148 minutes. That's a longer wait than
most movies just to watch a one-minute clip. Take a look at the following table to get a good idea
how long it takes to download files from the Internet.
Content

Size

14.4 Kbps

28.8 Kbps

64 Kbps

1.5 Mbps

Small graphics and
animation

30 KB

30 seconds

10 seconds

6 seconds

1 second

Small complete movie
clip

100-200
KB

180 to 300
seconds

90 to 180
seconds

20 to 40
seconds

1 second

Short video clip

500 KB

300 to 400
seconds

120 to 240
seconds

90 seconds

3
seconds

» HP Pavilion notebook PCs

Optimized for entertainment, HP
Pavilion notebooks have both
exquisite design and the
powerful features for TV,
photos, movies, music and
more.
» Notebook PC accessories

Table 5-2: Comparison of various file download rates and times.
It's also possible to create your own brief video clips right at your desktop. Fortunately, it's getting
easier all the time to capture and edit video on your PC.

Video compression
Because video files tend to be so large, it's best to consider employing some type of compression
before you post your video to your website. Compression is essentially the process of discarding
information from a video that isn't discernable to a viewer in order to reduce the size of the file. There
are a number of compression methods and tools available but the most popular format is MPEG
(Moving Picture Experts Group). The current standard for this format is MPEG-4, although MPEG-7
is under development.
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Windows provides a free video compression utility called Windows Media Encoder. This works only
on the Windows platform. For a utility that's both Windows and Mac friendly, use QuickTime. You
can download either version of QuickTime from Download.com.

Get video onto the web
Once you've created and optimized video for the web, you need to note where the video will appear.
Just like with audio files, you can either link to video using the standard HTML linking code, or you
can embed the video into the page. If you do embed video into an HTML page, use the following
code:
<embed width="100%" height = "100%"
fullscreen="yes" src="welcome.mov">
Unlike most web images, and some sound file formats, all video requires some kind of browser
plug-in in order to play. A plug-in is software that can handle file formats that your browser can't. To
play a video clip that is linked to the current page, for example, a site visitor needs to have a plug-in
that can read the video format you've chosen. Some plug-ins, such as Apple's QuickTime, Real
Networks' RealPlayer, or Microsoft Windows Media Player, can handle several audio and video
formats.
You can raise the chances that your plug-in-based video is viewable by most site visitors if you
include a link to a download site where site visitors can download the plug-in they need. You've
probably seen this before; a button and a bit of text that says you need QuickTime, RealPlayer,
or Windows Media Player to view a video image. Once the visitor downloads and installs the
plug-in, the video begins to play automatically according to the directions you've given in your
HTML code.
If you've been browsing the web for video files and playing them back, you've already noticed that
downloading these movies is a time-consuming task. This is why streaming video was invented. Like
streaming audio, a streaming video file begins playing right away as the file is being downloaded.
QuickTime Video, RealVideo, and Windows Media are all popular streaming video formats.

Just what is Shockwave?
Macromedia Shockwave is used for creating interactive multimedia. Like other types of multimedia, a
plug-in is required to view Shockwave files. Unlike audio and video files, your visitors can interact
with Shockwave files, which makes it a great format for online games. You can see great examples
of what's possible with Shockwave by visiting the Shockwave.com website.
You can create Shockwave files using Macromedia Director, which currently retails at over $1,200.
Most people creating multimedia for the web don't need Director, however. For less demanding
multimedia and for better web integration, Adobe offers Macromedia Flash. Priced at $400, it's a
much less expensive and an easier to learn solution than Director.
One of the advantages of Flash is that the file sizes are remarkably small, and the plug-in is small
as well. The result is that Flash content is rapidly becoming as widespread as the use of
animated GIFs.
Audio, video, Flash, oh my! What if you just want to put some of your existing collateral and printed
material on the web? If other types of multimedia are so easy to add, you can bet that adding your
existing materials is just as simple. In the next section, you'll learn the ins and outs of adding
presentations and printed documents to your site.

Putting a slide show and printed documents on the web
There may come a time when you want to present a series of informational slides to folks who visit
your website. This course, for example, could be presented in a classroom setting with a slide
projector displaying information and illustrations. Most people have seen presentations built with
Microsoft PowerPoint, and many have used it to build their own. Available for both Mac and PC,
PowerPoint is the most widely used slide creation (presentation) software available, but it isn't alone
in the market. Keynote is a popular Mac alternative to PowerPoint.

» Norton Internet Security
2008
» HP Total Care owner
services

With PowerPoint, you can easily turn your presentations into HTML documents ready to publish to
the web. PowerPoint helps you customize your presentation. For example, you can include
animations, use frames, choose the way you move to other slides or documents, and select different
button styles. PowerPoint maintains the interactive settings that jump to other slides or documents.
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To publish pages to the web with PowerPoint:
1. Open the presentation you want to save in HTML format.
2. Select File > Save As, select Web Page and then follow the instructions.
Figure 5-3 shows a screenshot of a PowerPoint presentation that's been saved as a web page.

Protect your investment and
achieve greater peace of mind
with the right HP Extended
Service Plan for your needs.

Figure 5-2: A slide show generated from PowerPoint.
Enlarge image
You can find many examples of PowerPoint presentations by searching the web for slideshow or
PowerPoint slideshow.

Publish printed documents to the web as PDFs
If you've browsed the web for a while, you've probably come across PDF files. PDF (Portable
Document Format) files are an invention and trademark of Adobe Systems. Essentially, PDF files are
duplicates (in appearance and content) of documents created in a word processor, spreadsheet, or
desktop publishing application, to name a few. The advantage of PDF is that anyone who has the
free Acrobat Reader program can read and print the files, regardless of which application was used
to create them. PDFs weren't invented for the web, but they can easily be added to a website, and
are viewable and sometimes editable there. When you install the current version of Acrobat Reader,
a web plug-in is also installed in your browser's Plug-Ins folder.
The IRS uses PDF files to enable folks to download tax forms right from the IRS website. When you
find the form you're looking for (in this case a W-9 form), just click the link and you'll see something
that looks like Figure 5-3.
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Figure 5-3: Viewing an Adobe Acrobat PDF file on the IRS site.
Enlarge image
Figure 5-3 illustrates just how valuable a utility Adobe PDF is. You can create forms and display
complete brochures. You can link to PDF files in the same way you link to other web pages.

Wrap up
The best way to learn the proper way to create and use multimedia is to experiment with it. Find out if
your website building software of choice provides any assistance with inserting multimedia, try
creating different kinds of multimedia, and record and edit your own sound files and video. Live it up.
In Lesson 6, you'll find out how to make your site more visible and draw in the visitors.
To review the material in this lesson and to get started with your multimedia adventure, take a stab at
the quiz questions and the assignment. As always, we encourage you to share your experiences and
ask questions on the Message Board.

Congratulations on completing the lesson! Don't forget the following:
» Assignment: Test the multimedia waters
» Quiz: Lesson 5, quiz 1
» Discuss what you've learned with your instructor and other students
» Return to the lessons list to get a quick overview of the entire class

Privacy statement

Using this site means you accept its terms
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Jazz up your website with multimedia assignment
Assignments are designed to help you apply the information learned in the lessons.
Test the multimedia waters
Multimedia doesn't always have a place on everyone's website. If you can't think of a good
reason to implement it, chances are you shouldn't. When purposefully employed, however,
multimedia enhancements can give your web site a real edge over those competing for its
attention. The trick is to employ meaningful content, giving users a reason to stick around. For
example, if you're advertising your private swing dance lessons, you could include a few video
clips to teach people the basic steps. If you're promoting your band or teaching the Korean
alphabet, don't miss the opportunity to include some audio files.
Visit the Message Board and discuss whether multimedia has a place in your project at this
time and how you plan to integrate it. If you run across examples out there of very useful -- or
shamelessly gratuitous -- multimedia, please share them.
You have completed this assignment.

Privacy statement
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Lesson 5, quiz 1
Quiz: Lesson 5, quiz 1
Quizzes are designed to give you a chance to test your knowledge.
Please feel free to take this quiz again. We will update your score.

1. About how many homes and businesses in the United States have broadband Internet access?
A.

10 million

B.

25 million

C.

50 million

D.

100 million

2. True or False: WAV is a type of video file.
A.

True

B.

False

3. True or False: A streaming media file begins to play only after your computer reads the entire file.
A.

True

B.

False

4. True or False: The best way to reduce the size of an audio or video files is through compression.
A.

True

B.

False

5. If you want to post a word processing document or spreadsheet on the web, which technique easily solves your problem?
A.

Use Adobe PDF

B.

Use Macromedia Flash

C.

Encode the file in HTML

D.

Use Adobe Reader

Privacy statement
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» Contact HP

Phone orders 1-877-801-7183

Search:
Home & Home Office

All of HP United States

Lesson 5, quiz 1
» Home & Home Office
My Cart
0 items in My Cart

Quiz: Lesson 5, quiz 1
Quizzes are designed to give you a chance to test your knowledge.
Please feel free to take this quiz again. We will update your score.

Hello, Truitt
» Edit profile
» Sign out
» Online classes
» Your classes
» Contact us
» FAQ
»
»
»
»
»

Digital Photography
Everyday Printing
PC Learning Center
Digital Entertainment
Activity Center

Browse & Buy
» Home & Home Office
Store
» Find a retailer
» Rebate Center
Product Support
» Support &
troubleshooting
» Software & Drivers
» HP Total Care
» Register your product

Quiz Results
1. About how many homes and businesses in the United States have broadband Internet access?
A.

10 million

B.

25 million

C.

50 million

D.

100 million

Correct answer(s): C
Explanation:
About 50 million and counting.

2. True or False: WAV is a type of video file.
A.

True

B.

False

Correct answer(s): B
Explanation:
A WAV file is an uncompressed, non-streaming audio file. WAV files can be very large and take a long
time to download. They usually don't require a plug-in.

3. True or False: A streaming media file begins to play only after your computer reads the entire file.
A.

True

B.

False

Correct answer(s): B
Explanation:
A streaming media files begin to play as it is downloading.

4. True or False: The best way to reduce the size of an audio or video files is through compression.
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A.

True

B.

False

Correct answer(s): A
Explanation:
Compression can dramatically reduce file size before affecting the quality of the piece.

5. If you want to post a word processing document or spreadsheet on the web, which technique easily
solves your problem?
A.

Use Adobe PDF

B.

Use Macromedia Flash

C.

Encode the file in HTML

D.

Use Adobe Reader

Correct answer(s): A
Explanation:
Adobe's PDF format easily converts any document file (word processing, desktop publishing, or
spreadsheet, for example) to a viewable and printable web document.

You got 5 correct out of 5 questions.
Your Score: 100%

Printable version
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Lessons - Plan and build your first website (with
podcast)
Plan and build your first website (with podcast)
» Lessons
» Message board

Welcome to your lessons. Some lessons may have quizzes or assignments for additional
learning. Don't forget to join your fellow classmates and instructor on the message board.

Lesson 6

» View single page

About search engines and directories
You're finished. You're ready to open the doors and let in the cheering crowds. Don't break out the
champagne just yet. You still have a lot of work to do. Your first step is to get your website listed on
all the major search engines and directories.

» Compaq Presario CQ50Z
series

What's a search engine?
You're probably thinking, I already know what a search engine is, why are they going to explain it to
me? Well, there are some common misconceptions out there about search engines and what they
do, and we're here to set you straight.
A search engine is a site that compiles a database of websites using a spider program. When you
enter a term in a search engine's keyword field, the search engine doesn't search the entire Internet
at that exact moment and return the results to you. Instead, it searches its own internal database
and then displays results of this search.
A spider is a piece of software that browses the web, similar to what a human user does, but much
faster and more thoroughly. When a spider hits a page on your website, it gathers information on
the page, and then follows all links on that page and gathers info on those. And then it follows all of
the links on all of those pages, and gathers info on those. And so on, and so on.
So, if my website is on the web, it'll be on a search engine, right?
Well, maybe, but it may take a long time for the spider to get to you. After all, there are millions of
web pages. So you have to tell it to visit your site. You do that by visiting the major search engine
sites and submitting your site. Your site is then put on a list to be indexed (visited) by the spider,
and will likely be indexed within a few weeks.

With thin lines, a cool touchpad
design, and a sleek,
touch-control panel, this 7.0 lb.,
15.4" laptop PC redefines
simplicity. In addition to being
ultra stylish, the PCs in the
Presario CQ50Z series are
durable, powerful, and
value-priced.
» Notebook PC accessories

Because so many search engines have consolidated in the past few years, there are only three
search engines you need to target:
Google
Yahoo!
MSN
Figure 6-1 shows what you can expect to see when you submit your site to Google. You just type
your URL and add any comments about the content, and then submit it.

From software, memory, and
cards to carrying cases and
docks, look to HP for all the
accessories you need to make
your notebook PC more suited
to your personal needs.

Figure 6-1: Submitting a URL to Google.
Enlarge image
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If you've created a site map on your site, submit that page's URL to the search engines. It links
to all parts of your site, after all.
After you submit your URL to these search engines, the rest of the work is done for you. Most
second-tier search engines use one of the three major search engines to perform their search
operations. For example, AltaVista uses Google and Netscape uses Yahoo!.

Well, then, what's a directory?
A directory site can seem the same as search engine, but it's actually a human-edited hierarchical
directory of websites. Key examples of directories are:
Yahoo! Search Directory
LookSmart
dmoz Open Directory Project
To have your site listed on a directory, you have to submit it for consideration. Some directories,
such as LookSmart and Yahoo! Search Directory, charge you a fee to be listed (check the site for
the current pricing). Others, such as Open Directory, are free, with no guarantee that your site will
be added.
To submit your site to Open Directory, go to the dmoz website, navigate to the category appropriate
for your website, and click suggest URL on the toolbar. You're then taken to a form in which you
can enter your site's URL, title, and description.
Follow all instructions on the dmoz website to make it more likely that your site will be included.

So, should I use a search engine submission service?
The number of well-trafficked search engines and directories is small enough these days to allow
you to submit your site to all of them yourself in about 1 hour. The real value provided by search
engine submission services is in setting up your site for the best performance on a search engine.
You can do this work yourself, though, if you'd like to save some dough. By following our
suggestions on the next few pages of this lesson, your site will be well equipped to show up high in
the rankings for appropriate searches. So, let's move on to learning about metadata and other
low-cost ways to promote your site.

Understand search engine relevancy
Search engines have gotten incredibly sophisticated over the past decade. They each use complex
and slightly different algorithms to determine the ranking of pages relevant to the key words or
terms being searched. Think about it, there are hundreds of millions of pages on the web. Imagine
how difficult it must be for a search engine to determine which page is most closely related to what
you're looking for.

» Norton Internet Security
2008

Each search engine performs the deed a little differently; however, the fundamentals are the same:
the page that has the most content about what is being searched, combined with the most traffic
from other people interested in the same information, wins.

Content
The best thing you can do to help your website be listed high on a search engine's list of relevant
pages is to make sure your headers and subheads accurately reflect what you sell or want to be
known for. If you sell kites, for example, put a few headers and subheads on your pages that have
the word kite in them.
You can also help your relevancy by using links and alternate text that use the words and terms a
web surfer is most likely to type into a search engine to find a product or service like yours. Of
course, make sure there is plenty of body text about your product or service also.

Links
If your site and your competitors' sites have roughly the same amount of content relating to a
specific search, the search engine can't call it a tie. It has to choose one over the other to list. As a
second measure of a web site's relevancy, a search engine looks at human behavior, as well; if
humans value one site more than another, that site gets listed higher.

Travel the Internet while
protected against viruses,
hackers, spyware, and spam.
Stay safe as you e-mail, swap
files, download programs, and
chat. You're automatically
protected when you've got
Norton Internet Security 2008,
updated and enhanced with
more features than ever.
» HP Total Care owner
services

The search engine determines how much humans value each site by looking at how much traffic
each site gets and how many people link to that site. They figure if humans like the site well enough
to visit it and link it to their own content, then that's probably a pretty good endorsement.
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Swapping links with other websites is a really good idea, not only to drive traffic to the site but to
show your relevancy to a search engine.

Meta tags
When search engine results are returned, the title of your website listing is whatever you've entered
in the <title> HTML tag for your homepage. The blurb below the title is whatever you've put in the
description <meta> tag.
In Figure 6-2, you can see that Into The Wind Kites is the title in that page's HTML tag for the
company's homepage, and the meta tag says, "Hundreds of classic, sport and power kites,
accessories, building materials, flags, windsocks and . . . "

Protect your investment and
achieve greater peace of mind
with the right HP Extended
Service Plan for your needs.

Figure 6-2: Meta tags define and describe your site to a search engine.
Enlarge image
You use meta tags to control the presentation of your website listing on search engines. So, be
sure to add meta tags to your homepage -- and all the other pages of your site as time permits -- to
ensure you're being shown in your best light.
Meta tags for search engine placement
The keywordsmeta tag is very important, too. It's a list of words and phrases relevant to your
website. A search engine spider indexes all of the text on your website along with the metadata, but
there are probably some words or phrases relevant to your site that aren't explicitly mentioned on
any of your web pages. Include those terms in the keywords meta tag. Also list more obvious
keywords, such as string for the previous example. It's best to be thorough.
Keep your keywords meta tag to a reasonable length, and keep those keywords relevant to your
website. Otherwise, your site might be removed from search engines. Don't put your
competitors' names in your keywords meta tag in hopes of luring their customers away -- that's
a big no-no.
Using meta tags appropriately can help your website relevancy for appropriate searches, and
ensure the way it's listed is how you like it. In the next section, you'll learn how to advertise your site
without breaking the bank.

The best free and low-cost promotion techniques
There was a time when many website owners had money to burn when it came to marketing their
sites. Remember the Pets.com sock puppet? Those days are definitely over. Now, most people
want to promote their sites with minimal cash investment. Here are some of the best ways to do it.

» Desktop PCs

Google AdWords
The most popular search engine today, Google is known for providing excellent search results. You
can buy a piece of that action through the company's AdWords program.
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Look at the Google search results in Figure 6-3. Notice that the first two results, and six others
down the right side of the screen, are labeled Sponsored Links. These are paid advertising spots
purchased by the listed sites.

View our wide selection of
desktop PCs to see reliable HP
quality at a great value. We'll
even help you choose the right
desktop for your unique needs.
» Desktop PC accessories

From software and storage to
cables, mice, and keyboards,
all the accessories you need for
your HP desktop PC are
available to make your desktop
experience more personal,
powerful, and attuned to your
specific needs.
Figure 6-3: Google search results with sponsored links.
Enlarge image
The sponsored link listed on top is a premium listing, which is somewhat expensive. The
sponsored links down the right side are purchased through Google AdWords, which is fairly
cost-effective. You only pay when someone clicks your ad, and you can set a budget limit that stops
showing your ad once you've spent that amount.

Link swaps
A time-tested method of promoting your site is through swapping links with other websites. The best
approach is to swap ads with websites that are complementary to your industry or service, rather
than competitive. Just contact the website administrator (this information is usually available on the
site) and ask.
Some website administrators want you to post an image, such as their company's logo, rather
than just a text link. If so, ask for the same treatment in return.
Link swaps can even help improve your site's performance on search engines. As you learned
earlier in the lesson, most search engines weigh sites by how many other sites link to them. This
means a site with more links to it will be listed higher than similar sites with less links to them. This
makes link swaps doubly good.

Customer service
Perhaps the most important and enduring way of promoting your site is by providing excellent
customer service. If you're selling a product or a service, word-of-mouth will most likely be your top
means of attracting new customers -- if your customer service is good, that is.
Your number one goal should be to bridge that communication gap that exists on the web. Stay in
contact with your customers. If your customers purchase products, let them know when they're
expected to ship, when they ship, and when to expect delivery. Give your customers
package-tracking information, too.
The same applies if you're providing a service. Keep in touch with your client regularly through
status updates or other regular communication. The key is to keep the customer in the loop.
If you provide excellent customer service, your site is guaranteed to generate good word-of-mouth
advertising. And when it does, it'll snowball into a bunch of happy customers who keep coming
back. In the next section, you'll learn other tips for keeping customers coming back for more.

Keep your website up to date
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One key aspect of website ownership is the ongoing task of keeping your site current. There are
two reasons you want to keep your website up to date:

» HP Pavilion Elite d5000t
ATX series

People will get bored and stop coming back if nothing ever changes on your site.
Search engines might drop your listing. That's right! Some search engines check to see if
your site is old and musty -- if it is, they delete you.
Here are some good ways to get people to come back to your site time and time again:
Post a monthly newsletter about your company or your industry
Add a blog, bulletin board, or live chat to your site
Add an RSS (Really Simple Syndication) feed to automatically give people updates when
they occur
Give away something for free (a report, a sample, and so on)
Run a monthly contest

Syndicated content
One place you can go to get some fresh content for your site is FreeSticky. This site is a content
syndication service that distributes a broad selection of written, graphical, audio, and video content
from almost 1,000 sources to a vast and diverse network of more than 200,000 websites. Just sign
up, paste some code into your website, and you're in business.

Get premium performance and
maximum expandability with
our Pavilion Elite d5000t ATX
series. With quad-core
processor technology and
discrete graphics on a full ATX
motherboard, this dynamic PC
will meet your most demanding
business and entertainment
needs. Note: this series is only
available online.

Affiliate programs
Another way to keep your site up to date, promote it, and make some additional money on the side
to boot, is to join one or more affiliate programs. For example, if you join an online bookstore's
affiliate program, every time someone buys a book as a result of a hyperlink from your site, you get
a small percentage.
When you sign up for an affiliate program, you're given an ID and some HTML that contains that ID
embedded in it. You add this information to URLs on your site. The site you're affiliated with may
ask you to display a banner or button announcing your relationship with them. When someone
clicks the links you've created and ends up buying something at the remote site, it's cash city for
you (maybe).
The focal point of affiliate programs is LinkShare.com, as seen in Figure 6-4. Notice the wide
selection of programs.

Figure 6-4: LinkShare.com.
Enlarge image
Each of these companies will supply you with one or more types of links to their sites. Some of
these will be text hyperlinks and some will be banners. The affiliate site will provide you with HTML
code to insert into your web pages, depending upon what kind of link you want to set up.
You may choose to run affiliate links as banners on the top or bottom of your page, or use them to
highlight products related to your industry, or recommended by you or your colleagues.

Wrap it up
In this course, you learned to design an effective website, use a web design tool to develop it, find
an appropriate ISP to host it, use multimedia and interactivity to spice it up, and effectively promote
your site. With hard work and a little luck, you'll have a great first website up and running soon -- if
you don't already.
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It takes a lot of effort to thrive on the web. One thing you can do is stay informed, which means
finding out everything you possibly can about the business of the web. To that end, here's a list of
places you can go to keep up with your reading:

» Compaq FS7600 17"
flat-screen CRT monitor

WebsiteTips
Good Practices
ZDNet
ecommerce-guide.com
CNET News.com
But before you go, complete your last assignment and quiz, and stop by the Message Board one
last time to share your thoughts and discoveries -- and find out what your classmates are up to.
Good luck with your website!

Want stellar viewing plus
minimal glare and distortion?
With 0.25–0.28 mm dot pitch,
and 1280 x 1024 maximum
resolution, this flat-screen CRT
monitor will supply you with a
steady stream of crisp, clear
images.

Congratulations on completing the lesson! Don't forget the following:
» Assignment: Get your site noticed
» Quiz: Lesson 6, quiz 1
» Discuss what you've learned with your instructor and other students
» Return to the lessons list to get a quick overview of the entire class
Class Certificate

Click the image or download the class certificate.
Related classes
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Promote your website assignment
Assignments are designed to help you apply the information learned in the lessons.
Get your site noticed
1. Find five websites that are complementary to your website's big idea and collect
contact information for possible link swaps.
2. Create or revise your website's title and description, which can be used to determine
how your listing looks in search engines.
3. Come up with a list of 25 to 40 keywords that are relevant to your web site.
4. If your website is already partially or fully developed, add these meta tags to every
page.
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Lesson 6, quiz 1
Quiz: Lesson 6, quiz 1
Quizzes are designed to give you a chance to test your knowledge.

1. What is a search engine?
A.

A site that compiles a database of websites using a spider program

B.

A human-edited hierarchical listing of websites

C.

A means of adding links to your website

D.

A site that contacts you via e-mail for information about your website

2. True or False: Meta tags determine a page's ranking by a search engine.
A.

True

B.

False

3. What is one of the best ways to build a community of loyal customers for your site?
A.

Great customer service

B.

Flash demos

C.

Banner ads

D.

Colorful marketing brochures in PDF format

4. True or False: Freesticky.com is an affiliate program
A.

True

B.

False
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» Contact HP

Phone orders 1-877-801-7183

Search:
Home & Home Office

All of HP United States

Lesson 6, quiz 1
» Home & Home Office
My Cart
0 items in My Cart

Quiz: Lesson 6, quiz 1
Quizzes are designed to give you a chance to test your knowledge.
Please feel free to take this quiz again. We will update your score.

Hello, Truitt
» Edit profile
» Sign out
» Online classes
» Your classes
» Contact us
» FAQ
»
»
»
»
»

Digital Photography
Everyday Printing
PC Learning Center
Digital Entertainment
Activity Center

Browse & Buy
» Home & Home Office
Store
» Find a retailer
» Rebate Center
Product Support
» Support &
troubleshooting
» Software & Drivers
» HP Total Care
» Register your product

Quiz Results
1. What is a search engine?
A.

A site that compiles a database of websites using a spider program

B.

A human-edited hierarchical listing of websites

C.

A means of adding links to your website

D.

A site that contacts you via e-mail for information about your website

Correct answer(s): A
Explanation:
A search engine is a site that compiles a database of websites using a spider program.

2. True or False: Meta tags determine a page's ranking by a search engine.
A.

True

B.

False

Correct answer(s): B
Explanation:
Meta tags are just one way a search engine determines a site's ranking.

3. What is one of the best ways to build a community of loyal customers for your site?
A.

Great customer service

B.

Flash demos

C.

Banner ads

D.

Colorful marketing brochures in PDF format

Correct answer(s): A
Explanation:
Great customer service generates good word-of-mouth, which builds a community of loyal customers.
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4. True or False: Freesticky.com is an affiliate program
A.

True

B.

False

Correct answer(s): B
Explanation:
Freesticky.com is a syndicated content service. Like an affiliate program, it can help keep your site up
to date.

You got 3 correct out of 4 questions.
Your Score: 75%
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